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C H A P T E R  1

Getting Started

The Octel 50 Supervisor’s Guide is designed to provide information
and guidance for administering and maintaining the Octel 50 system.

This chapter provides basic information on using the Octel 50
onscreen interface. The steps in this chapter help you:

• Navigate the Octel 50 screens

• Restart the Octel 50 system

• Use this manual

This manual provides information on using all available Octel 50
features and options. Note, however, that all features and options are
not available with all systems.
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Navigating System Screens

An Octel 50 screen can have several components.

Buttons–Buttons represent available options. To select a button, you
can:

• Press <ALT> and the highlighted letter in the button name.
For example, press <ALT+E> to select the Exit button.

• Point and click on the button using a mouse.

• Use the <TAB> key to highlight the button, and press
<ENTER>.

Fields–Fields are areas of the screen where input is entered using
the keyboard. A field is ready to accept input when it is active. To
enter data in a field, you can:

• Point and click on the field using a mouse

• Use the <TAB> key to highlight the field, enter the
information, and press <ENTER>.

Propeller–The spinning propeller indicates that the system is active
and ready to process calls. If the propeller stops spinning for more
than a few seconds, contact your authorized representative.
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The Octel 50 main screen contains two default displays, Mailbox
Status and Channel Status, and the main menu bar, which provides
access to system features. To change the default displays, see the
topic, “Save Screen Layout,” in Chapter 7, “The Options Menu.”

Mailbox Status–Mailbox Status indicates the number of new and
saved messages in each mailbox on the system. Mailbox Status
must be closed to access the main menu bar option. To close the
Mailbox Status, select Exit or press <ESC>.

Channel Status–Channel Status displays the current status for each
installed port, up to four ports at a time. Channel Status shows
“Waiting for ring...” or “Waiting for DID...” if the port is unoccupied by
a caller. When a port answers a call, you can monitor the caller’s
actions on this display. For information on viewing the rest of the
ports on the system, see Chapter 6, “The Display Menu.”

Channel Status also displays the current system date and time. The
time based on the date and time set on the PC.

Main Menu–Seven menus display across the top of the Octel 50
Main screen:  File, Mailbox, Attendant, Reports, Display, Options,
and Help. These menus allow you to access the functions and
features of Octel 50. To access main menu options, you must exit
the Mailbox Status display.

 To open a menu:

• Use the <TAB>, <SHIFT+TAB>, or right and left arrow keys
to move the highlighted bar among the menus. Once your
choice is highlighted, press <ENTER>.

• Press <ALT> and the highlighted letter in the menu name.
For example, press <ALT+F> to open the File button.

• Point and click on the button using a mouse.
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Restarting the System

You may have to manually start the Octel 50 system after you
perform maintenance procedures requiring the system to be shut
down. During installation, your authorized representative may have
configured Octel 50 to automatically start any time the PC is
rebooted. If Octel 50 is not configured to start automatically after a
reboot, you can restart the Octel 50 system using following
procedures.

To restart the Octel 50 system:

1. Turn on the Octel 50 PC if it is not already on.

2. From the DOS prompt, type CD CVR then press <ENTER> to
access the \CVR directory.

3. From the \CVR prompt, type RUNSMO3 then press <ENTER>.
The Octel 50 main screen displays.

For information on shutting down the Octel 50 system, refer to
Chapter 2, “The File Menu.”

Using this Manual

Each Octel 50 menu is described in a separate chapter. The sections
are arranged in the order the menus are presented on the main
menu bar. It may be necessary to refer to two different sections of
the manual to activate a feature.

The Troubleshooting the System section provides information to help
you solve problems you may encounter.

Appendix A contains a series of forms to help you configure the
system features.
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C H A P T E R  2

The File Menu

The options available from the File menu allow you to:

• Access system options using a password

• Change system passwords

• Log off from a security level

• Exit Octel 50
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Password

A password is a series of digits that allows you to access certain
system menu options. Octel 50 has three levels of security access:

• Level 1 Security Access–This level does not require a
password. Anyone with access to the system’s keyboard has
level 1 security access. Level 1 security allows you to select the
Exit and Password options from the File menu, all of the Display
menu options except Command Line, and the Help menu.

• Level 2 Security Access–This level permits access to all
options under the following menus:  File, Mailbox, Attendant,
Reports, Display, and Help. The only function accessible through
the Options menu is AMIS Maintenance. The default password
for level 2 security is 12345. Give this password to any supervisor
who is permitted to create, edit, and delete mailboxes; access
reports; edit attendant functions; and configure Administered
AMIS nodes.

When accessing supervisor functions over the phone, use the
level 2 password. See Chapter 10, ”Supervisor Keypad
Functions,” for more information.

• Level 3 Security Access–This level permits access to all menu
options, including the Options menu selections. The default
password for this level is 67890. It is recommended that you
have only one level 3 supervisor.

It is strongly recommended you change the default passwords to
avoid unauthorized access to the system. For information on
changing system passwords from the defaults, refer to Change
Password.



The File Menu Password

Octel 50 Supervisor’s Guide 2-3

To log into the system:

1. From the File menu, select Password. The Supervisor Password
dialog box displays.

2. Enter the supervisor password and press <ENTER>.

As you enter your password, notice that it is displayed as a series
of asterisks on the monitor for security purposes.

3. When you enter a valid password, the system displays, “Thank
you, you have level 2 (or 3) security access.”

4. Press <ENTER> or select OK.

Do not change the level 2 password to be the same as the level 3
password. If this happens, entering the password provides you with
level 2 access only. To correct the problem, change the level 2
password to regain access to level 3 features.

Once you finish performing any supervisory functions, you should
always select Logoff from the File menu. Otherwise, anyone having
access to the system’s PC could change mailbox setups, delete
mailboxes, or alter certain parameters that could disable the system.

Although Octel 50 allows any number of mailboxes to be designated
as supervisor mailboxes, all supervisors must use the same
supervisor password to access and modify system features through
both the keyboard and the telephone keypad. Therefore, as a
supervisor, you really have two passwords when calling into the
system—a subscriber password to access your own mailbox and a
supervisor password to access system features.
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Change Password

The Change Password option changes the supervisor password for
the current security level. If you are logged in with level 2 security
access and select Change Password, only the level 2 password is
changed. Similarly, if you are logged in with level 3 security access
and select Change Password, the level 3 password is changed.

The supervisor password must be between 2 and 9 digits in length
and cannot begin with zero.

To change the supervisor password:

1. From the File menu, select Change Password. The Change
Password dialog box displays.

 

2. In the Enter new password field, enter the new password. For
security, the password displays in the field as a series of
asterisks (*).

3. Verify the password by reentering it in the second field. If you
entered the same password in both fields, the system displays,
“Your new password has been accepted.”  If the second entry is
not the same as the first, the system prompts you to try again.

4. Once the new password is accepted, select OK.

So you have a record of your password, write it down and keep it in a
safe place. If you forget your password, you will not be able to access
system features.
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Logoff

Logoff returns security access to level 1. This prohibits others from
using the PC keyboard to change features.

Always log off the system when you are finished performing
supervisory functions.

To log off the system:

1. From the File menu, select Logoff.

2. When logoff is complete, a message box informing you that
security is returned to level 1.

3. Select OK.

Logoff does not shut down the Octel 50 system. To shut down the
system, select Exit from the File menu.

Exit

When you select Exit, the system disables all available ports so that
no additional incoming calls are received. Occupied ports are
disabled as calls on those ports are completed. Once all ports are
disabled, the system shuts down and returns to DOS.

To avoid irreparable file damage, never turn off, restart, or reboot
your PC without properly exiting the Octel 50 software. Exit the
program by selecting Exit from the File menu or typing SHUTDOWN
and pressing <ENTER> from the Command Line Interface.
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To shut down the system:

1. Select Exit from the File menu. The Shutdown System dialog box
displays.

 

2. Select Shutdown. The system shutdown completes and the
\CVR prompt displays.

About Force Shutdowns

The Shutdown System dialog box contains an option to perform a
Force shutdown. When you select the Force System Down option,
the system shuts down immediately, and any active calls on the
system are terminated. Do not perform a force shutdown unless
instructed to by a technical support representative.
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C H A P T E R  3

The Mailbox Menu

The Mailbox menu contains options that allow you to:

• Create subscriber and guest mailboxes

• Edit subscriber mailboxes

• Delete mailboxes

• Clear information from mailboxes

• Search for a mailbox
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Create Mailboxes

Octel 50 allows you to create system mailboxes and configure the
features you want to enable for each mailbox. This section provides
information on creating mailboxes using the onscreen interface. For
information on creating mailboxes over the phone, see Chapter 10,
“Supervisor Keypress Options.”

Before you create mailboxes, be sure to configure classes of service
for the system. A class of service is a set of features that is assigned
to a mailbox. If you do not want to use one of the 25 predefined
classes of service, you can create a custom class of service for
individual mailboxes. For information on modifying classes of service,
see the topic, “Class of Service,” in Chapter 7, “The Options Menu.”

To create mailboxes:

1. From the Mailbox menu, select Create. The Create Mailbox
dialog box displays.

For convenience, it is recommended that you create supervisor
and default operator mailboxes first.

 

To activate a certain field on the screen, you can press <TAB> or
<SHIFT+TAB> keys to highlight the field or point and click the
mouse on the field. Use the <ENTER> key to accept input for the
entire dialog box.

2. In the Create _ Mailboxes field, enter the number of mailboxes
you want to create.
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3. In the Starting with Box field, enter the first mailbox you want to
create.

4. In the Increment By box, use arrow keys to move through the
choices, and press <Spacebar> to select your choice.

5. Select Create. The Mailbox Entry dialog box displays the first
mailbox with the mailbox number displayed in the Mailbox field.
This number cannot be changed.

 

6. To create all of the new mailboxes with the default system
features, select Save. A dialog box displays informing you that
the mailboxes have been created.

If you want the mailboxes to have the same features, configure
the first mailbox before you select Save.

7. In the Extension field, enter the extension for the mailbox if it is
different from the mailbox number.

When entering the extension number, you can include the
following special codes if necessary:

Code Represents

& Flash hook

, Pause (length specified in System Setup)

M (followed by a number) MF type dialing
(requires supporting hardware)

T (followed by a number) Return to DTMF dialing
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8. In the First Name field, enter the first name of the mailbox
subscriber.

9. In the Last Name field, enter the last name of the mailbox
subscriber.

The mailbox owner’s first and last names are used in directory
listings, reports, and searches. If you do not enter a name for a
mailbox, that mailbox is not included in any system reports or
searches. So the names can be alphabetized on reports properly,
capitalize the first letter of both first and last names.

10. In the Company Name field, enter the name of the company to
which the mailbox subscriber belongs, up to 10 characters. The
company name you enter allows subscribers to send messages
to all subscribers in the same company through system-wide
distribution lists. Note that the company name must match the
company name entered for other mailboxes exactly.

11. In the Division field, enter the name of the division to which the
mailbox subscriber belongs, up to 10 characters. The division
name you enter allows subscribers to send messages to all
subscribers in the same division through system-wide distribution
lists. Note that the division name must match the division name
entered for other mailboxes exactly.

The Company and Division fields must be used consistently to
properly create global distribution lists *98 and *99. Mailboxes not
assigned a Division or Company are included in all division- and
company-wide distribution lists, respectively.

12. If the system is not set up to assign passwords, and you want the
mailbox to have a password, enter the password for the mailbox
in the Password field. Subscriber passwords must be between 1
and 9 digits in length and cannot begin with zero. The system
displays the password as asterisks (*) for added system security.

 If the Minimum Length Password parameter is defined in System
Setup as a number greater than 4 or if the parameter is changed
to a new minimum length after a user’s mailbox is established,
the subscriber is prompted to enter a new password that
complies with the defined minimum number of digits before
proceeding.
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13. If the mailbox requires a personal operator other than the default
operator, enter the mailbox number of the personal operator. The
personal operator is the person to whom a mailbox’s calls default
when a caller presses <0> to speak to an operator after an
extension is either busy or not answered. Also, if a mailbox’s
calls are being handled by a V-Tree, and a caller in the V-Tree
presses <0>, the caller is transferred to this operator’s extension.

Callers who press<0> at the initial greeting are transferred to the
system default operator specified in System Setup or the
personal operator of the mailbox that answers for greeting by
port.

14. To assign a predefined class of service to the mailbox, enter the
class of service number in the Class of Service field. To view the
predefined classes of service, select View/Edit to display the
specified class of service. Use the Next and Prev buttons to view
the available classes of service.

 
15. If the features for the predefined classes of service are not

appropriate, you can select Create Custom COS to create a
custom class of service, if you are logged in as a level 3
supervisor.  For information on individual class of service
features, see the topic, “Class of Service,” in Chapter 7, “The
Options Menu.” To assign the custom class of service, select
Accept. The Mailbox Entry dialog box displays.

When you create a custom class of service, 0 is displayed in the
Class of Service field on the Mailbox Entry screen.
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16. If you want to automatically forward messages in the mailbox to
another mailbox, select Auto Forwarding under Edit, then select
the appropriate options. For additional information, see the topic,
“Auto-Forwarding,” later in this chapter.

17. If you want to notify the mailbox subscriber of messages in the
mailbox by pager or call forwarding, select Message Delivery,
then select the appropriate options. For additional information,
see the topic, “Message Delivery,” later in this chapter.

18. If you want to change the settings the subscriber can assign to
the mailbox, select Subscriber Settings, then select the
appropriate options. For additional information, see the topic,
“Subscriber Settings,” later in this chapter.

19. If you want to create a guest mailbox for the mailbox, select
Guest Mailbox, then select the appropriate options. Note that this
option is not available until you save the mailbox the first time.
For additional information, see the topic, “Creating a Guest
Mailbox,” later in this chapter.

20. If you want to create or assign a V-Tree to the mailbox, select
Visual V-Tree, then select the appropriate options. Note that this
option is not available until you save the mailbox the first time.
For additional information, see Chapter 11, “V-Trees.”

21. To save the entered features, select Save. The Mailbox Saved
dialog box displays.

22. Select OK. The Mailbox Entry dialog box displays.

23. To enter mailbox features for the next newly created mailbox,
select Next and repeat this procedure starting with step 7.

24. To close the Mailbox Entry dialog box, select OK. The new
mailboxes display on the Mailbox Status screen of the Octel 50
main window.
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Auto Forwarding

Auto forwarding forwards messages that have not been listened to
for a specified AMount of time from the recipient mailbox to another
mailbox. For example, if a message from a prospective customer is
received in a salesperson’s mailbox and that salesperson has not
listened to the message during a specified length of time, the system
automatically places the message in another salesperson’s mailbox.

You can chain together several mailboxes for auto forwarding. For
example, messages in mailbox 1000 that are not listened to can be
forwarded to mailbox 1200. Then, auto forwarding can be configured
for mailbox 1200 to forward messages after the specified AMount of
time to mailbox 1300.

When you select Auto Forwarding, the Auto Forwarding dialog box
displays.

To configure auto forwarding for a mailbox:

1. Highlight Auto Forwarding Active, and press <SPACEBAR>.

2. Under Delay, in the Hours and Minutes fields, enter the length of
time a message can remain in the original mailbox before being
forwarded to the other mailbox. The maximum delay time is 127
hours, 59 minutes.

3. If you want the message to be deleted from the original mailbox
when it is forwarded to the other mailbox, select the Delete
Message After Forwarding option. If this option is not selected,
the message remains in the original mailbox, and a copy of the
message is forwarded to the other mailbox.

4. Once you enter your selections, press <TAB> until the OK box is
highlighted and press <ENTER>. (You can also press <ALT+O>
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or use the mouse to select OK.)  The Mailbox Entry dialog box
displays.

Message Delivery

The message delivery feature allows subscribers to be notified of
new messages in their mailboxes during a specified time frame by
having the system call them at a specified phone or beeper number.
For example, a mailbox can be set up to call the subscriber on a
beeper on weekends when the subscriber is away from the office.
This feature can also enable you to notify subscribers who do not
have message indicators on their phones that they have new
messages by having the system call their extension.

When the system calls to deliver a message, it voices the message
delivery prompt similar to, “Hello, this is your voice mail system. I
have a message for <subscriber’s name or mailbox number>. Please
enter your password.”  In the event that someone other than the
subscriber answers the phone, the system voices the announcement
three times, allowing the subscriber approximately one minute to get
to the phone and enter the password. If all attempts to reach the
subscriber are unsuccessful, the message is stored in the
subscriber’s new message queue for later retrieval.

Whether a message delivery attempt is successful is determined by
whether batch mode delivery is activated. The message delivery
mode is set in the class of service.  For additional information on
batch mode, see Chapter 7, “The Options Menu.”

When you select Message Delivery, the Message Delivery dialog box
displays.
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To configure message delivery for a mailbox:

1. In the Entry # field, select the number to assign to the message
delivery configuration. You can set up 8 different configurations
to have the system call a phone or beeper. For example, you
could specify Entry #1 to have the system call a beeper during
business hours, and specify Entry #2 to have the system call a
home phone number after business hours.

2. To turn the message delivery feature on for the entry, select the
Active option.

3. In the On Time field, enter the time of day to start message
delivery for the currently selected Entry number.

4. In the Off Time field, enter the time of day to end message
delivery for the currently selected Entry number.

5. In the On Day field, select the day to start message delivery for
the currently selected Entry number. To change the On Day,
press <ENTER> when the field is highlighted (or use the mouse
to point and click), and a menu of days displays. Use the up and
down arrow keys to select the day.

6. In the Off Day field, select the day to end message delivery for
the currently selected Entry number. To change the Off Day,
press <ENTER> when the field is highlighted (or use the mouse
to point and click), and a menu of days displays. Use the up and
down arrow keys to select the day.

 The On Day and Off Day you select determines the range of
days the feature is active. For example, if you specify Tuesday as
the On Day and Sunday as the Off Day, the message delivery
feature will be active during the times you specify for every day of
the week except Monday.

The Off Time/Off Day specified must be later than the On
Time/On Day.

7. Under Retries, in the Max Attempts field, enter the maximum
number of times the system should attempt to either call the
phone number or beeper.
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8. Under Retries, in the Busy Delay field, enter the number of
minutes the system should wait before re-attempting to call a
number that is busy.

9. Under Retries, in the No Ans Delay field, enter the number of
minutes the system should wait before reattempting to call a
number when there is no answer at the number.

10. In the Phone # field, enter the phone number to dial to notify the
subscriber that a new message is in the mailbox. If the digits in
the phone number are less than the number of digits defined as a
local number in System Setup, the system assumes the number
is an internal extension. If the number contains at least the
defined number of digits, the code to access an outside line is
used to place the call. If the number is for a beeper, the letter N
should usually precede the number so that call progress is not
used.

For both the Phone and Call Back fields, the following entry
options are also available and are useful with WATS lines and
pagers. You can use as many different characters as needed.
However, if you use N for no call progress, it must be in the first
character position.

Code Represents

& Flash hook

, Pause (length specified in System Setup)

M (followed by a number) MF type dialing
(requires supporting hardware)

N (followed by a number) No call progress
(some beeper paging systems emit tones

that can disrupt message delivery,
use N to ignore the tones)

P (followed by a number) Pulse (not tone) dialing

T (followed by a number) Return to DTMF dialing
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If subscribers specify the message delivery phone number
through the telephone, they can include the following special
codes in the phone number:

Code Represents

*1 Pause

*2 Flash hook

*3 DTMF

*4 Pulse

*5 No call progress

** Star

11. In the Call Back field, enter one of the following:

• The number you want to display on the beeper when the
subscriber is notified. This number is usually the number the
subscriber should call to access the system.

You may need to enter a comma or series of commas before
the call back number to ensure the paging system receives
the call back number.

• PHONE to have the system call the entered phone number
and voice, “I have a message for <subscriber’s name>,”
when the subscriber answers the phone.

• OPER to have the system call the entered phone number and
voice, “<mailbox number> has not picked up messages,”
notifying the operator that the subscriber has not listened to
messages in the mailbox. If you enter OPER in this field, the
outcall will not be rescheduled. For this reason, it is
recommended that a message delivery entry using OPER
come last.

12. In the Line 1 field, enter the system port to be used if you want to
use a specific port to call the subscriber. Make sure this line has
been set to 2 in the OUTBOUND parameter in System Setup. To
use any available port to call the subscriber, enter 99.

13. To configure another entry for message delivery, use the Next or
Prev buttons and repeat this procedure starting with step 1.
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14. To save the entered message delivery entries, select OK. The
Mailbox Entry dialog box displays.

Note that message delivery times can overlap. For example, suppose
entry #1 is scheduled to deliver messages to one location between
9:00 AM and 5:00 PM, and entry #2 is scheduled to deliver to another
location between 12:00 noon and 6:00 PM. Also, assume that the
Busy and No Answer Delays for each entry are set to 30 minutes,
and the Maximum Retries field is set to four. If a message is received
in the mailbox at 11:30 AM, the system will attempt to deliver the
message under entry #1 first, outdialing at 11:30 AM, 12 noon, 12:30
PM, and 1:00 PM. After the Maximum Retries have been exhausted
for the first entry, the system will immediately try entry #2, attempting
deliveries at 1:00 PM, 1:30 PM, 2:00 PM, and 2:30 PM.

Subscriber Settings

Use the following procedures to help manage the settings
subscribers have applied to their system mailboxes. You can view
options a subscriber currently has set up and change those settings
based on the subscriber’s needs.

When you change subscriber settings, you can enable features that
are not enabled in the mailbox’s class of service. If you enable a
feature for a mailbox that is not active in the class of service, the
subscriber cannot change the option, except to turn a feature off.
Once one of these features is turned off, the subscriber cannot turn it
back on.
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When you select Subscriber Settings, the Subscriber Settings dialog
box displays.

To modify subscriber settings:

1. To set all of the subscriber settings to the system defaults, select
Set to Defaults. This feature allows you to reset all current
settings that you or the subscriber has previously set for the
mailbox.

2. Under Intercom Paging select the appropriate option:

• Off–Does not allow callers to page subscribers through the
intercom.

• On–Provides callers the option to page subscribers through
the intercom if there is no answer at the extension.

• Automatic–Automatically pages the subscriber through the
intercom if there is no answer at the extension.

• Number–Specifies the paging number if the On or Automatic
option is selected. Enter the number to call to page the
subscriber, if it is different than the system default paging
number. For example, if the system uses zone paging, enter
the number for the zone to which the mailbox is assigned. If
the field is left blank, the system calls the default paging
number set up on the system.

Intercom paging is available only if an intercom is connected
to the system and an intercom paging number is specified
either in System Setup or in the Number field.



The Mailbox Menu Create Mailboxes

Octel 50 Supervisor’s Guide 3-14

If a subscriber is paged through the intercom, the subscriber
can reroute the call from the mailbox to another extension on
the system using the intercom redirect feature. If a
subscriber does not answer a page, the caller has the option
of leaving a message for the subscriber, calling a different
mailbox, transferring to the operator, or disconnecting.

You can enter the following codes in the Number field when
specifying an individual paging number. Note that the letter
R must always follow a letter D or N. Otherwise, the R is
ignored. If a release code is needed on a connect, follow the
R with the necessary codes or commands.

Code Represents

& Flash hook

, Pause (length specified in System
Setup)

- On hook

+ Off hook

H Hard hangup (hangup/restart)

R Release code needed on
busy or no answer

X Extension (place extension in dial string)

C# Transfer code following, where # is the
number of characters in the code

D Dial with call progress

M MF type dialing
(requires supporting hardware)

N No call progress
(some beeper paging systems emit

tones that can disrupt message delivery,
use N to ignore the tones)

P Pulse (not tone) dialing

T Return to DTMF dialing

The options you select in steps 3-5 set up the Call Handling for
the mailbox, which determines how calls to the mailbox are
handled by the system under certain conditions.
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3. To block all incoming calls to a mailbox to an option you specify,
without first ringing the extension, select the Call Blocking option.

4. Under No Answer/Call Blocking, select the appropriate No
Answer option to perform when a caller receives no answer at
the subscriber’s extension, or select the appropriate call blocking
option if the Call Blocking option is selected:

• Default–Forwards callers to the subscriber’s mailbox.

• V-Tree–Activates the V-Tree assigned to the mailbox. Make
sure a V-Tree is created for the mailbox before you assign
this option.

• Optional 1–Voices the Optional 1 prompt, then forwards
callers to the subscriber’s mailbox.

• Optional 2–Voices the Optional 2 prompt, then forwards
callers to the subscriber’s mailbox.

• Forward To–Forwards callers to the mailbox number
entered in the field next to the option.

5. Under Busy, select the appropriate option to perform when a
caller receives a busy signal when calling the subscriber’s
extension:

• Default–Forwards callers to the subscriber’s mailbox.

• V-Tree–Activates the V-Tree assigned to the mailbox, if one
has been assigned.

• Optional 1–Voices the Optional 1 prompt, then forwards
callers to the subscriber’s mailbox.

• Optional 2–Voices the Optional 2 prompt, then forwards
callers to the subscriber’s mailbox.

• Forward To–Forwards callers to the mailbox number
entered in the field next to the option.

6. Under Message Delivery, select the appropriate option to notify
users of new messages:

• Disabled–Message delivery does not notify subscribers of
new messages.
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• Urgent Only–Notifies subscribers of new messages through
a phone or beeper only when urgent messages are sent to
the mailbox.

• All Messages–Notifies subscribers of any new messages
through a phone or beeper.

7. Under Special Options, select Announce Subscriber to have the
system voice, “I have a call for <subscriber’s name prompt>,”
instead of the default prompt, “One moment, you have a call,”
when the system transfers a call to an extension. This feature
enables subscribers to hear whom a call is for before the transfer
is completed, which is especially useful when multiple
subscribers share the same extension.

8. Under Special Options, select the Call Queuing option to place
callers in a queue when the extension is busy. Ensure that call
queuing prompts have been recorded so callers are notified
appropriately that their call is in a queue and will soon be
addressed.

9. Under Special Options, select the Call Screening option to
prompt callers to record their name to announce the call before
the subscriber receives it. This feature allows subscribers to
identify a caller and then determine if they want to receive the
call.

10. To save the changes made to the subscriber settings, select OK.
The Mailbox Entry dialog box displays.

Guest Mailboxes

A guest mailbox is created under the sponsorship of a system
mailbox and allows non-subscribers to send and receive messages.
Guest mailboxes provide a convenient way for communicating with
clients, potential customers, and other persons with whom a
subscriber needs to share information.

A guest mailbox can only send messages to the sponsoring mailbox,
but it can receive messages from any other mailbox. Since the guest
mailbox does not have access to other features, such as creating
distribution lists, call screening, call queuing, or intercom paging,
guest mailboxes cannot be edited.
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Guest mailboxes can also be created through the phone interface by
accessing a supervisor’s mailbox. From the Subscriber’s menu, while
in a supervisor’s mailbox, press <8> to create the mailbox, and enter
the sponsor mailbox number of the guest mailbox to create.

When you select Create Guest Mailbox, the Create Guest Mailbox
dialog box displays.

To create a guest mailbox:

1. In the Enter Mailbox Number field, specify the guest mailbox to
be created.

 This field defaults to the sponsor’s mailbox number plus one. If
that mailbox number exists, the guest mailbox will be the next
consecutive number. For example, if the host mailbox number is
1000 and mailboxes 1001 and 1002 already belong to system
subscribers, the default guest mailbox number is 1003.

2. Select Create. The Mailbox Saved dialog box displays.

3. Select OK. The Mailbox Entry dialog box displays the sponsor
mailbox settings.

Like other mailboxes, guest mailboxes can be deleted only by level 2
and level 3 supervisors. If a sponsor mailbox is deleted, all
associated guest mailboxes are also deleted.

Visual V-Tree

V-Trees are menus that you can create to provide callers with options
they can choose from to perform actions on the system. Callers use
a V-Tree the same way they use the Attendant menu on the system,
yet V-Trees are assigned to specific mailboxes, not to the entire
system.
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V-Trees can be created over the phone or on-screen. Visual V-Tree
is the on-screen interface for creating V-Trees, and it is only available
to supervisors through the Mailbox Entry dialog box. For more
information on creating V-Trees, see Chapter 11, “V-Trees.”

Duplicate Mailboxes

You can create a duplicate of an existing system mailbox. The
duplicate mailbox you create retains the features of the existing
mailbox, except the name, password, distribution lists, folders,
message delivery settings, auto forwarding settings, and V-Tree.

When you select Duplicate Mailbox from the Mailbox Entry dialog
box, the Duplicate Mailbox dialog box displays.

Make sure that the Mailbox Entry dialog box displays the mailbox you
want to copy before you select Duplicate Mailbox.

To create a duplicate mailbox:

1. In the Enter New Mailbox # field, specify the mailbox to be
created.

2. Select Create. The Mailbox Entry dialog displays the duplicate
mailbox.

3. Enter the mailbox information. For information on Mailbox Entry
dialog box fields, see the topic, “Create Mailboxes,” earlier in this
chapter.

4. Select Save. The Mailbox Saved dialog box displays.

5. Select OK. The Mailbox Entry screen redisplays, containing the
new mailbox.

6. To close the Mailbox Entry dialog box, select OK.
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Edit a Mailbox

When you edit a mailbox, you can edit any of the mailbox features
including the mailbox subscriber’s name and extension. This
procedure is especially useful if a subscriber leaves your office and
you want to assign the mailbox to a new employee without having to
create a new mailbox. Note that you can only edit one mailbox at a
time.

To edit a mailbox:

1. From the Mailbox menu, select Edit. The Edit Mailbox dialog box
displays.

2. Enter the mailbox number you want to edit, then select Edit. The
Mailbox Entry dialog box displays the mailbox features.

If you do not know the number of the mailbox you want to edit,
select Search and locate the mailbox. For additional information,
see the topic, “Search for a Mailbox,” later in this chapter.

3. Modify the mailbox settings you want to change. For information
on the Mailbox Entry dialog box fields, see the topic, “Create
Mailboxes,” earlier in this chapter.

4. Select Save to save the changes to the mailbox.

5. Select OK to close the Mailbox Entry dialog box. The Octel 50
main screen displays.
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Delete a Mailbox

To delete a mailbox:

1. From the Mailbox menu, select Delete. The Delete Mailbox
dialog box displays.

2. Enter the number of the Mailbox you want to delete, then select
Delete. The Delete Box dialog box displays.

If you do not know the number of the mailbox you want to delete,
select Search and locate the mailbox. For additional information,
see the topic, “Search for a Mailbox,” later in this chapter.

2. To delete the mailbox, select Yes. The system displays a
confirmation message.

3. Select OK to close the dialog box. The Delete Mailbox dialog box
displays.

4. You can enter another mailbox number to delete or, to return to
the Octel 50 main screen, select Cancel.

You can also delete a mailbox displayed on the Mailbox Entry
dialog box by selecting Delete on that dialog box.
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Clear a Mailbox

The Clear Mailbox option allows you to clear mailbox information for
specified mailboxes. For example, you can clear all of the mailbox
information for a mailbox whose subscriber is being transferred to
another office in the company and will no longer need the mailbox.
This allows you to reassign the mailbox to a new subscriber without
having to create a new mailbox.

When you clear mailboxes, you can specify which mailboxes to clear
by entering a range of mailbox numbers, a company, and/or a
division. Mailboxes that are not included in the range, company, and
division you enter are not cleared. You can clear the following
information for the mailboxes you select:

• Statistics–Erases all of the mailbox statistics that are
displayed when you generate mailbox reports. This enables
you to view mailbox statistics from the time you cleared the
mailbox statistics to the present date.

• Messages–Erases all new and saved messages in the
selected mailboxes.

• Prompts–Erases all of the prompts the subscribers have
recorded for the selected mailboxes and replaces the
prompts with the default system prompts.

• Distribution Lists–Erases all distribution lists created by the
subscribers in the mailboxes. Clearing distribution lists for
mailboxes does not clear system distribution lists.

• Guest Mailboxes–Deletes all guest mailboxes in the
selected mailboxes.

• Folders–Deletes all folders created by subscribers in the
selected mailboxes.

• V-Tree–Deletes the V-Trees from the selected mailboxes.

• Subscriber Settings–Resets all of the mailbox subscriber
settings to the default settings.
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To clear mailbox information:

1. From the Mailbox menu, select Clear. The Clear Mailbox dialog
box displays.

 

2. Under Items to be cleared, select the options for the items you
want to clear from the mailbox.

To clear information for a mailbox, the mailbox must be in the
entered range of mailbox numbers, in the entered company, and
in the entered division. If a mailbox does not meet all of the
entered values, the mailbox information is not cleared. For
example, if you include all mailbox numbers in the range, all
divisions, and enter ABC for the company, only mailboxes in
company ABC are cleared. Mailboxes in all other companies are
not cleared.

3. If you do not want to include all the system mailboxes in the
range to clear, enter the number of the first mailbox in the range
you want to clear in the From field under Clear Mailboxes, and
enter the last mailbox number in the range you want to clear in
the To field. If you only want to clear information for a single
mailbox, enter that mailbox number in both the From and To
fields.

4. In the Company field, enter the name of the company to clear or
enter All to clear mailbox information for all companies on the
system. If this field is left blank, the system includes all
companies in the range.

5. In the Division field, enter the name of the division to clear or
enter All to clear mailbox information for all divisions on the
system. If this field is left blank, the system includes all divisions
in the range.
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6. To clear the mailbox information based on the entered options,
select Clear. A clear mailbox confirmation dialog box displays.

7. Select Yes to continue. Once the mailboxes are cleared, the
message “Mailboxes Cleared” displays.

8. Click OK. The Clear Mailbox dialog box displays.

9. To close the Clear Mailbox dialog box, select Exit.

Search for a Mailbox

Use this procedure to locate a mailbox by the mailbox subscriber’s
last name. Depending on how you access the Search feature of the
system, you can view, edit, or delete mailboxes after locating a
mailbox.

To search for a mailbox:

1. Select Search from one of the dialog boxes on which it is
available. The Search dialog box displays all of the system
mailboxes alphabetically by the mailbox subscriber’s last name.

 

2. Use the up and down arrow keys to scroll through the list of
names. Use the Next and Previous buttons to display other
screens of names.

3. To search for a mailbox by entering the mailbox subscriber’s last
name, enter the name to search for in the Target field, then
select Begin New Search. The system displays the mailbox
name at the top of the list if a match was found. If a match of the
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name was not found, the next closest name alphabetically
displays.

4. Select OK to select the highlighted mailbox. If you searched for a
mailbox from the Edit dialog box or Mailbox Entry dialog box, the
selected mailbox displays. If you searched for a mailbox from the
Delete Mailbox, a deletion confirmation dialog box displays.
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C H A P T E R  4

The Attendant Menu

The Attendant menu contains options that relate to the automated
attendant feature. The automated attendant answers the phone with
a main greeting and guides the caller through the system. Through
the Attendant menu, you can:

• Configure the Attendant menu voiced to callers

• Configure holidays

• Configure system prompts

• Specify the company’s business hours
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Attendant Menu

The automated attendant feature allows you to provide options to
callers, such as contacting specific subscribers, leaving messages,
and sending faxes. For example, when callers call the company, the
attendant may give them the options to dial a particular extension,
press <1> to speak to sales, press <2> to speak to technical support,
press <3> to send a fax, or press <4> to leave a message. These
options are voiced to callers by the Attendant Menu prompt. The
Attendant Menu prompt is voiced after the morning, afternoon, and
evening System Greetings prompts, and the Language Selection
prompt, if one is set up on the system.

To configure the automated attendant, you must first record the
Attendant Menu prompt, then configure the Attendant Menu prompt
options. If no Attendant Menu prompt is recorded, the system voices
a default prompt. For information on recording the Attendant Menu
prompt, see Chapter 10, “Supervisor Keypad Options.”

To set up the automated attendant:

1. To configure the Attendant Menu prompt options, select
Attendant from the Attendant menu. The Attendant Main Menu
Editor dialog box displays.

 

2. Next to each keypress, indicate how the call is to be handled
when the caller selects that keypress. Ensure the entries you
indicate coincide with the options voiced in the Attendant menu
prompt. When you configure the Attendant Menu prompt options,
there are two different options you can assign to a keypress:

• Mailbox Number–If you want callers to be transferred to a
particular mailbox, enter the mailbox number in the field.
Callers selecting the associated Attendant menu keypress
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are transferred to the extension associated with the mailbox.
Any call handling set up for the mailbox remains in effect
when the call is transferred. For example, if you want to
transfer callers to mailbox 3124 when they press <2>, type
3124 next to the 2 keypress icon. If mailbox 3124 is
blocked by a V-Tree, callers pressing <2> hear the V-Tree
prompt.

• MESSAGE–If you want callers to transfer directly to voice
mail to leave a message for a subscriber, type MESSAGE in
the field. The system prompts the caller to enter the
destination mailbox and to record the message.

3. To save the entered automated attendant options, select OK.
The Octel 50 main window displays.

Holidays

The holiday feature allows you to designate specific days the office is
closed as holidays and record special holiday greetings. During days
designated as holidays, the system voices the Holiday Greeting
prompt all day instead of the System Greetings prompts (morning,
afternoon, evening, and closed). Any messages left by callers are
stored in the After Hours Operator mailbox if it is specified.
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To set up Holiday prompts:

1. From the Attendant menu, select Holidays. Note that you can
also access the Holidays dialog box from the System Prompts
dialog box by selecting the Holiday Greetings button. The
Holidays dialog box displays.

 

2. In a Date field, enter the date of the holiday in month, day
(MM/DD) format. You can define up to 18 holidays.

3. In the Msg # field, enter the prompt number of the prompt you
want the system to voice on the corresponding date. Make sure
that you record the specified prompt. If you do not record a
prompt, a default greeting is used, and the call is transferred to
the after hours receptionist.

4. If you want the system to automatically retain the same date as a
holiday for the next year and voice the same prompt, select the
Retain option next to the Msg # field.

5. To save the entered Holiday prompts, select OK. The Octel 50
main window displays.
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Prompts

System Prompts are the prompts to be voiced for morning, afternoon,
evening, closed, language selection, attendant menu, message
delivery, holiday, and call queuing greetings.

If you do not specify prompt numbers for each of the standard office
greetings, default system prompts are used. When you select
Prompts, the System Prompts dialog box displays.

You can record these prompts through the Supervisor menu over the
phone or by using SOLVE. See Chapter 10, “Supervisor Keypad
Functions,” for recording instructions or contact your authorized
representative for information on obtaining professionally-recorded
customized prompts. To specify a prompt, enter the number of the
prompt in the corresponding field.

If you are using professionally-recorded prompts, precede the prompt
number with the letter D. This indicates that the prompt is stored in
the SO3-D2.VAP (for Dialogic boards) or SO3-D2.VOX (for Rhetorex
boards) phrase file. For additional information, contact your
authorized representative.

When callers dial the Octel 50 system on a typical day, the first
prompt they hear is the appropriate System Greeting prompt (or the
Greeting by Port prompts, if set up). An example is, “Hello and thank
you for calling ABC corporation.”  If the Octel 50 system includes
language files for multiple languages, the next prompt callers hear is
the Language Selection prompt, such as, “For service in English,
press <1>. Pour la service en Français, appuyez sur <2>.”  Once
callers select a language, the remaining system prompts are voiced
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in that language. The Attendant Menu prompt is voiced next to guide
callers through the system. A typical Attendant Menu prompt is,
“Enter the extension of the person you would like to speak with, or
press <1> to speak to sales, press <2> to leave a message, press
<3> to send a fax, or press <0> to speak to an operator.”  Depending
on the selections the callers make, callers are transferred to
extensions or the operator, or hear prompts for mailboxes,
instructions for voice mail, or instructions for sending faxes.

System Greetings

System Greetings are prompts that are voiced at specified times of
the day. These prompts include a morning, afternoon, evening, and
an office closed prompt. The System Greeting prompt is the first
prompt voiced by the system to callers (on days not specified as
holidays). A typical morning System Greeting prompt may say, “Good
morning, thank you for calling ABC Corporation.”

Entries under Time/Date in System Setup determine when the
morning, afternoon, and evening greetings are voiced. The daily
business hours specified using the Business Hours option under the
Attendant menu determine when the office closed greeting is voiced.

The System Greetings prompts are not voiced if the greeting by port
feature is used.

Morning–This is the prompt that callers hear during morning
business hours. For example, “Good morning, thank you for calling
Acme Manufacturing...”

Afternoon–This prompt greets callers during afternoon business
hours. For example, “Good afternoon, thank you for calling Acme
Manufacturing...”

Evening–This prompt answers calls during evening business hours.
For example, “Good evening, thank you for calling Acme
Manufacturing...”

Closed–This prompt greets callers during non-business hours. For
example, if the end of the business day is at 5:00 PM, callers after
5:00 PM hear the closed prompt, not the Evening prompt. An example
of a closed prompt is, “Thank you for calling Acme Manufacturing.
Our regular business hours are between 8:00 AM and 5:00 PM,



The Attendant Menu Prompts

Octel 50 Supervisor’s Guide 4-7

Monday through Friday. Please leave a message at the tone, and
we’ll return your call as soon as possible.”

The morning, afternoon, evening, and closed prompts are each
followed by the phrases, “Please enter the extension number of the
person you would like to speak with,” and, “If you do not know the
extension number, press the star button for directory services.”
These phrases are stored in the SO3-ALL.VAP (Dialogic) or
SO3-ALL.VOX (Rhetorex) phrase file.

Language Select Prompt

The Language Select prompt prompts callers to select the language
they would like to use. For example, “For service in English, press
one. Pour la service en français, appuyez sur deux.”

Attendant Menu

The attendant menu can direct callers to the proper extension or
department. If your system is using multilingual capabilities, you need
to record the attendant menu prompt in each language. For example,
“For sales, press one. For accounting, press two. For technical
assistance, press three. Or, to send a fax message, press four,
followed by the extension number.”

Message Delivery

The message delivery prompt is voiced when the system makes a
message delivery attempt. If your system is using multilingual
capabilities, you need to record the message delivery greeting in
each language since subscribers can use an alternative language for
their mailboxes. An example of this prompt might be, “Hello, this is
the Acme Manufacturing’s Octel 50 voice mail system. I have a
message for... .”  After your custom phrase, the system will insert the
Mailbox Owner’s Name prompt (or mailbox number if no prompt has
been recorded), followed by, “Please enter your password.”



The Attendant Menu Prompts

Octel 50 Supervisor’s Guide 4-8

Holiday Greetings

When you select Holiday Greetings, the Holiday dialog box displays.
For information on specifying holiday greetings, see Holidays.

Call Queuing Prompts

Call queuing prompts are voiced to callers while they are on hold in
the queue. An example of a call queuing phrase is, “Thank you for
holding. At this time, all of our service technicians are helping other
customers. Please continue to hold, and we assure that you will
receive the same careful attention.”  When you select Call Queuing
Prompts, the Call Queuing Prompts dialog box displays.

Nine standard call queuing phrases can be voiced to callers. In each
numbered field, enter the number of the call queuing prompt you
want the system to voice to callers.

The caller occupying the first place in the queue hears the Call
Transfer phrase. The Call Transfer phrase should be a phrase such
as, “Please hold, your call will be handled by the next available
salesperson.”  This phrase should be short, since the system voices
the entire phrase before transferring the caller, regardless of when
the line becomes available. In the Call Transfer Prompt field, enter
the number of the phrase to be voiced to the first caller in the queue.

If a caller has been holding in the queue long enough to hear all 9
standard phrases, the phrases start over again, until the caller
reaches the first position.

To accept the entered prompts, select OK. The Mailbox Entry dialog
displays.
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Business Hours

Business Hours determine the company’s office hours and whether
callers to the system hear the appropriate time of day greeting or the
closed greeting.

Morning, afternoon, and evening hours are specified under
Time/Date in System Setup.

To configure business hours:

1. Select Business Hours from the Attendant menu. The Daily
Business Hours dialog box displays.

 

2. To select the day of the week for which you want to specify
business hours, highlight the Sunday button and press
<ENTER>.

3. Select the appropriate day of the week from the menu that
displays.

4. In the box below the day of week, select the appropriate business
hours option.

• Open All Day–The time of day greetings (morning,
afternoon, and evening) are voiced at the appropriate times
during the day at the times specified in System Setup under
Time/Date. The office closed greeting is not voiced during
that day.

• Closed All Day–The office closed greeting is voiced during
the whole day. The time of day greetings are not voiced
during that day.
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• Selected Hours–The time of day greetings are voiced during
the times specified in the Open and Close fields. The office
closed greeting is voiced the rest of that day.

5. If you chose the Selected Hours option, enter the time of day the
company opens for business and closes in the Open and Close
fields in either standard AM/PM format.

6. If you want to configure several consecutive days with the same
daily business hours, select Copy To: to copy the information to
the next day.

7. To save the entered daily business hours, select OK. The Octel
50 main window displays.
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C H A P T E R  5

The Reports Menu

From the Reports menu, you can generate reports that provide
information about the Octel 50 system.
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Generating Reports

To generate a report:

1. From the Report menu, select the name of the report you want to
generate. The Reports dialog box displays. The name of the
selected report displays in the upper-left corner of the dialog box.

2. Under Sort By, specify whether the report should be sorted by
name or by mailbox number.

3. In the Company field, specify the company to be included in the
report.

4. In the Division field, specify the division to be included.

5. Under Destination, specify whether the report should be sent to a
printer or saved to a disk file. If you choose Disk, the Enter the
destination filename dialog box displays.

6. Enter the destination path and filename for the report. If you do
not specify a path, the report is saved to the \CVR directory.
Assign the reports descriptive names, such as JULY99.RPT.

7. Click OK to generate the selected report as specified.
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Reports other than the Mailbox Information report are automatically
created in comma-delimited ASCII format.

Mailbox Quick List

The Mailbox Quick List report provides the following information:

Name–Displays the mailbox subscriber’s last name then first name
separated by a comma.

• Box #–Displays the system mailbox number.

• Extension–Displays the mailbox subscriber’s telephone
extension.

• Company–Displays the mailbox subscriber’s company.

• Division–Displays the mailbox subscriber’s division.

MAILBOXES–QUICK LIST          11/01/98     11:03 AM Page 1

Name Box # Extension Company Division
Williams,Jane 1000 1000 ABC Sales
Feather,Heidi 1100 1100 ABC Sales
Fulton,John 1200 1200 ABC Sales
Teller,Susan 1300 1300 ABC Sales
Hunter,Beth 1400 1400 ABC Sales
Kessle,Joan 1500 1500 ABC Sales
Pattser,Amber 1600 1600 ABC Sales
Robinson,Kim 1700 1700 ABC Sales
Green,Emily 1800 1800 ABC Sales
Brown,Daniel 1900 1900 ABC Sales
Winters,Robert 2000 2000 ABC Support
Graham,Ellen 2100 2100 ABC Support

Mailbox Usage

The Mailbox Usage report provides the following information:

• Mailbox–Displays the system mailbox number.

• Name–Displays the mailbox subscriber’s name.
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• Company–Displays the mailbox subscriber’s company.

• Division–Displays the mailbox subscriber’s division.

• Msgs–Displays the total number of messages that have been
sent to the mailbox.

• Sub–Displays the total amount of time, in minutes, the subscriber
spent logged into the mailbox.

• Non Sub–Displays the total amount of time, in minutes, that
non-subscribers spent in the mailbox. This includes the time a
non-subscriber spent using a V-Tree in a mailbox.

• In–Displays the total number of calls transferred to the mailbox
from the automated attendant.

• Out–Displays the total number of times the mailbox used an
outbound port for calls, such as sending message deliveries,
sending faxes, lighting message waiting lights, or delivering
wake-up calls.

Totals for this report are accumulated from the date that the mailbox
was created and are reset when the mailbox statistics are cleared.

MAILBOXES - USAGE              11/01/98           11:03 AM           Page 1

Mailbox Name Company Division Msgs Sub NonSub In Out

1000 Williams,Jane ABC Sales 49 57m 20m 27 5
1100 Feather,Heidi ABC Sales 139 176m 87m 74 31
1200 Fulton,John ABC Sales 80 128m 39m 75 0
1300 Teller,Susan ABC Sales 124 339m 58m 68 23
1400 Hunter,Beth ABC Sales 99 167m 60m 10 126
1500 Kessle,Joan ABC Sales 177 273m 168m 28 109
1600 Pattser,Amber ABC Sales 76 84m 56m 51 3
1700 Robinson,Kim ABC Sales 147 145m 49m 39 12
2300 Toth,Frank ABC Support 90 146m 187m 40 20

Mailbox Information

The Mailbox Information report displays detailed information for each
mailbox, as well as mailbox statistics for both the current and last
month. The Total column is accumulated from the date that the
mailbox was created and is reset when the mailbox statistics are
cleared. The report consists of the following information:

• Mailbox Number–Displays the system mailbox number.
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• Extension–Displays the mailbox subscriber’s extension number.

• Class of Service–Displays the class of service number assigned
to the mailbox.

• Subscriber–Displays the mailbox subscriber’s name.

• Date of Last Use–Displays the date the subscriber last
accessed the mailbox.

• Calls Received–Displays the total number of times the extension
has been dialed.

• Mailbox Used –Displays the number of times the mailbox owner
accessed the mailbox.

• Messages–Displays the number of messages sent to the
mailbox.

• Message Time–Displays the total length of time, in seconds, of
the messages in the mailbox.

• Subscriber Time–Displays the amount of time, in minutes, the
subscriber was logged into the mailbox.

• Non-Subscriber Time–Displays the length of time a non-
subscriber accessed the mailbox.

• Outcalls–Displays the total number of times the mailbox used an
outbound port for calls, such as for message delivery, sending
faxes, lighting message waiting lights, or delivering wake-up
calls.

• Outcall Time–Displays the total number of minutes used for
outcalls.

• Transfers (BUSY)–Displays the number of attempted transfers
from the attendant when the extension was busy.

• Transfers (NOAN)–Displays the number of attempted transfers
from the attendant when the extension was not answered.

• Transfers (To Ext)–Displays the total number of successful
transfers to the extension.

• Faxes Sent–Displays the number of faxes sent from the mailbox.
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• Faxes Received–Displays the number of faxes received to the
mailbox.

• AMIS Admin Outbound–Displays the total number of
administered outbound AMIS messages from the mailbox.

• AMIS Casual Outbound–Displays the total number of casual
outbound AMIS messages from the mailbox.

• AMIS Inbound–Displays the total number of inbound AMIS
messages to the mailbox.

MAILBOXES–INFORMATION 11/01/98     11:38 AM                       Page 1

Mailbox number: 1400 Ext: 1400 COS: 1

Subscriber: Adams,Tom ABC Sales

Date of last use: 10/28/98 Personal Operator:

Cur Last Total Cur Last Total
Calls Received: 12 10 22 Mailbox Used 13 13 31
Messages: 8 9 17 Message Time (m) 30 18 48
Subscriber Time(m): 19 17 36 NonSub Time: 5 7 12
Outcalls: 2 0 2 Outcall Time (m): 3 0 3
Transfers (BUSY): 4 2 6 Transfers (NOAN): 8 5 13
Transfers (To Ext.): 8 12 20
Faxes Received: 2 1 3 Faxes Sent: 1 2 3
AMIS Admin Outbound: 3 8 11 AMIS Inbound: 3 8 11
AMIS Casual Outbound: 6 5 11

Port Assignments

The Port Assignment report is based on greeting by port information.
For information on configuring greeting by port, see Chapter 7, “The
Options Menu.” The Port Assignments Report displays the following
information:

• Port–Displays each system port by number.

• Active–Displays whether the port is active for greeting by port.

• During Hours–Displays the mailbox number assigned to answer
that port’s calls during business hours.

• After Hours–Displays the mailbox number assigned to answer
that port’s calls after business hours.
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• Day, Open, and Close–Displays the business hours assigned to
the port.

PORT ASSIGNMENTS       11/01/98     03:57 PM             Page 1

Port   Active     During Hours  After Hours   Day     Open     Close

0 Yes 1000 1200 Sun     Open all day
Mon     Open all day
Tue     Open all day
Wed     Open all day
Thu     Open all day
Fri     Open all day
Sat     Open all day

1 Yes 1100 1300 Sun     Closed all day
Mon     800  1700
Tue     800  1700
Wed     800  1700
Thu     800  2000
Fri     800  1500
Sat     1200  1700

2 Yes 1400 1400 Sun     1200  1800
Mon     1000  1800
Tue     1000  1800
Wed     1000  1800
Thu     1000  1800
Fri     1000  1800
Sat     1000  1800

3 Yes 1500 1500 Sun     Closed all day
Mon     Open all day
Tue     Open all day
Wed     Open all day
Thu     Open all day
Fri     Open all day
Sat     Open all day
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Class of Service

The Class of Service report shows the settings of the features
contained in the 25 predefined classes of service. The sample report
below shows class of service numbers 1-9 only.

CLASS OF SERVICE REPORT    11/01/98      11:14 AM                   Page 1

                           COS Number
1 2 3 4 5 6 7 8 9

Msg Waiting Lights No No No No Yes Yes Yes Yes No
Call Screening Yes No Yes Yes Yes Yes Yes Yes Yes
Distribution Lists Yes No Yes Yes Yes Yes Yes Yes Yes
Call Queuing Yes No Yes Yes Yes Yes Yes Yes Yes
Save Messages Yes Yes Yes Yes Yes Yes Yes Yes Yes
Undelete Messages Yes Yes Yes Yes Yes Yes Yes Yes Yes
Intercom Paging No No No No No No No No Yes
V-Trees Allowed No No Yes No No Yes No Yes No
Msg Confirmation Yes No Yes Yes Yes Yes Yes Yes Yes
Supervisor Mailbox No No No No No No No No No
Access Dir
Services

Yes Yes Yes Yes Yes Yes Yes Yes Yes

Record Prompts Yes Yes Yes Yes Yes Yes Yes Yes Yes
Message Scan Yes Yes Yes Yes Yes Yes Yes Yes Yes
Voice Folders Yes No Yes Yes Yes Yes Yes Yes Yes
Call Handling Yes No Yes Yes Yes Yes Yes Yes Yes
Edit Sent Message Yes No Yes Yes Yes Yes Yes Yes Yes
V-Tree Fax Support No No No No No No No Yes No
Global Dist. Lists Yes No Yes Yes Yes Yes Yes Yes No
Send Messages Yes Yes Yes Yes Yes Yes Yes Yes Yes
Receive Messages Yes Yes Yes Yes Yes Yes Yes Yes Yes
Outcalling Type Local None Local Local Local Local Local Local Local
Message Delivery No No No No No No No No No
Operator Access Yes Yes Yes Yes Yes Yes Yes Yes Yes
Max. # of Messages 30 30 30 30 30 1000 30 30 30
Max. Sing. Msg
Time

300 300 300 300 300 32000 300 300 300

Total Msg Time 0 0 0 0 0 0 0 0 0
Days for New Msg 7 7 7 7 7 7 7 7 7
Days for Saved Msg 14 14 14 14 14 14 14 14 14
Ring Count 5 5 5 5 5 5 5 5 5
Send Faxes No No No No No No No No No
Receive Faxes No No No No No No No No No
AMIS Administered No No No No No No No No No
AMIS Casual No No No No No No No No No
AMIS Replies No No No No No No No No No
AMIS Method None None None None None None None None None
AMIS Msg Leng. Sec 0 0 0 0 0 0 0 0 0
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Prompt Assignments

The Prompt Assignments report displays the prompt numbers
assigned to specific greetings and messages on the System Prompts
dialog box. If the letter D precedes a phrase number, the phrase has
been professionally recorded and is stored in the SO3-D2.VAP (for
Dialogic boards) or SO3-D2.VOX (for Rhetorex boards) phrase file. If
there is no designated prompt for a specific greeting, a default
greeting is used.

SYSTEM PROMPT ASSIGNMENTS  11/01/98   11:14 AM

Area Of Use Prompt #

Morning Greeting D34
Afternoon Greeting D35
Evening Greeting D36
Closed Greeting D37
Multi-Lingual Selection .

Call Transfer Phrase 50
Call Queuing Phrase #1 51
Call Queuing Phrase #2 52
Call Queuing Phrase #3 53
Call Queuing Phrase #4 54
Call Queuing Phrase #5 55
Call Queuing Phrase #6 56
Call Queuing Phrase #7 57
Call Queuing Phrase #8 .
Call Queuing Phrase #9 .

Main Menu Language #1 40
Main Menu Language #2 .
Main Menu Language #3 .
Main Menu Language #4 .
Main Menu Language #5 .

Message Delivery Language #1 42
Message Delivery Language #2 .
Message Delivery Language #3 .
Message Delivery Language #4 .
Message Delivery Language #5 .

Holiday #1 12/25 Save 100
Holiday #2 11/26 101
Holiday #3 04/22 102
Holiday #4 01/01 Save 110
Holiday #5 .
Holiday #6 . .
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AMIS Statistics

The AMIS Statistics report allows you to create custom reports
containing information about messages sent and received using the
AMIS Interface Module (AIM). Two different types of reports can be
generated, Tracking Reports or the Node Information Report.

The Tracking Report is a log of activity for inbound and outbound
AMIS messages. You can select to show both inbound and outbound
or only one. You also have the option to select all activity or only a
listing of errors. The sample reports show examples of Inbound-Error
Only, Outbound-Error Only, Inbound All and Outbound All, and a
Node Information Report.

The Node Information Report may be sorted by node number,
access phone number, or system name.

Additionally, any of the AMIS reports can be sent to a printer or a disk
file. Due to the length of these reports, only partial reports are shown.
The Tracking Report displays the following information:

• Access Number–Displays the phone number the system dials to
send messages to another voice mail system. The word Local
indicates the call was received by the system.

• Date–Displays the date the message was sent or received.

• Time–Displays the time when the message was sent or received.

• Method–Displays the dispatch option selected for the mailbox.

• Connect Status–Displays whether or not a connection was
established with the other voice mail system and the networking
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protocol used to send the message. The status n/a indicates the
call was received by the system.

• Channel–Displays the port on which the message was sent or
received.

• Box ID–Displays the number of the mailbox to which the
message was sent.

• Duration–Displays the total length, in seconds, of the message.

• Origination–Displays the access number of the system from
which the message was sent. If the message was sent from the
local system, the column displays the word Local.

• Message Status–Displays whether the message was received.
If the message was not received, the column displays the error
the system encountered. For additional information on network
message errors, contact your authorized representative.

• Retry–Displays the number of times the system attempted to
send the message to another voice mail system.
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INBOUND ERROR TRACKING - AUDIT TRAIL 09/10/98     04:26 PM                                     Page 1

ACCESS NUMBER BOX ID DATE TIME DURATION(sec.) METHOD-MSGS ORIGINATION CONNECT STATUS MESSAGE STATUS CHANNEL

LOCAL 1005 09/06/98 04:01 PM 1 n/a 14055693 n/a Bad connection 2

LOCAL 2060 09/07/98 04:07 PM 1 n/a 14055693 n/a Node deleted 9

LOCAL 3000 09/07/98 08:49 PM 23 n/a 14055693 n/a Rejected call 3

LOCAL 1000 09/08/98 09:01 AM 1 n/a 14055693 n/a Bad line 2

*** End of Report ***

OUTBOUND ERROR TRACKING - AUDIT TRAIL 09/10/98      04:26 Page 1

ACCESS NUMBER BOX ID DATE TIME METHOD-MSGS ORIGINATION CONNECT STATUS MESSAGE STATUS CHANNEL RETRY

44555 1042 09/06/98 04:01 PM IMMEDIATE-0 LOCAL Supported AMIS NODE DISABLE 2 0

44555 2060 09/07/98 04:07 PM IMMEDIATE-0 LOCAL Supported AMIS NODE DISABLE 2 0

44555 1838 09/07/98 08:49 PM IMMEDIATE-0 LOCAL Supported AMIS NODE DISABLE 2 0

44555 1045 09/08/98 09:01 AM IMMEDIATE-0 LOCAL Supported AMIS NODE DISABLE 2 0

*** End of Report ***

INBOUND CHECKING - AUDIT TRAIL 09/17/98      03:00 PM                                      Page 1

ACCESS NUMBER BOX ID DATE TIME DURATION(sec.) METHOD-MSGS ORIGINATION CONNECT STATUS MESSAGE STATUS CHANNEL

LOCAL 1000 09/06/98 04:01 PM 1 n/a 14055693 n/a Delivered 2

LOCAL 2000 09/07/98 04:07 PM 1 n/a 14055693 n/a Bad line 9

LOCAL 1000 09/07/98 08:49 PM 23 n/a 14055693 n/a Mailbox full 3

LOCAL 1000 09/08/98 09:01 AM 1 n/a 14055693 n/a Delivered 2

*** End of Report ***

OUTBOUND CHECKING - AUDIT TRAIL 09/10/98      04:26 PM                                             Page 1

ACCESS NUMBER BOX ID DATE TIME METHOD-MSGS ORIGINATION CONNECT STATUS MESSAGE STATUS CHANNEL RETRY

44555 1042 09/06/98 04:01 PM IMMEDIATE-0 LOCAL Supported AMIS Delivered 2 0

44555 2060 09/07/98 04:07 PM IMMEDIATE-0 LOCAL Supported AMIS NODE DISABLE 2 0

44555 1838 09/07/98 08:49 PM IMMEDIATE-0 LOCAL Supported AMIS Delivered 2 0

44555 1045 09/08/98 09:01 AM IMMEDIATE-0 LOCAL Supported AMIS NODE DISABLE 2 0

* End of Report ***
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The Node Information report displays the following information:

• Node Number–Displays the node number on the system.

• Status–Displays whether the node is active or inactive for
network events. The status may be inactive if either the system
manager deactivated the node or if the system deactivated the
node due to an excessive number of errors.

• Access Number–Displays the phone number the system dials to
send messages to the other voice mail system associated with
the node.

• System Name–Displays the name of the site or company for the
other voice mail system.

• Supervisor Name–Displays the name of the system manager for
the other voice mail system.

• Prompt Number–Displays the number assigned to the prompt
the system plays when the system voices the destination of a
network message for confirmation.

• Supervisor’s Box –Displays the mailbox number of the system
manager on the other voice mail system.

• Maximum Messages–Displays the maximum number of
messages allowed in a queue before the system sends the
messages.

• Maximum Delay–Displays the maximum amount of time the
system allows messages to wait in a queue before sending them.

• Weekdays On–Displays the hour beginning the weekday
economy hours.

• Weekdays Off–Displays the hour ending the weekday economy
hours.

• Weekends On–Displays the hour beginning the weekend
economy hours.

• Weekends Off–Displays the hour ending the weekend economy
hours.
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• Maximum Delay–Displays the maximum amount of time the
system allows messages to wait in a queue before sending them.

• Outbound Attempts–Displays the number of messages the
system attempted to send.

• Attempts Complete–Displays the number of outbound events
successfully completed.

• Message Attempts–Displays the number of messages the
system attempted to deliver.

• Messages Complete–Displays the number of messages
successfully delivered.

• Total Outcall Time–Displays the total length of time, in seconds,
of all messages sent.

• Total Message Time–Displays the total length of time, in
seconds, of all messages sent or received.

• Failed (Busy)–Displays the total number of times the system
encountered a busy condition at the other voice mail system.

• Failed (No Answer)–Displays the total number of times the
system encountered a no answer at the other voice mail system.

NETWORK NODE - INFORMATION 11/10/98    04:26 PM             Page 1

Node Number: 111 Status: Active
Access Number: 18135551234
System Name: Lab 1 Supervisor Name: Ellen Gray
Prompt Number: 20 Supervisors Box: 555
Maximum Msgs: 9 Maximum Delay: 90
Weekdays On: 2300 Weekdays Off: 0600
Weekends On: 2300 Weekends Off: 0600

OUTCALL Statistics: Cur Last Total MESSAGE Statistics: Cur Last Total
Outbound Attempts:  13 16 29 Message Attempts: 10 8 18
Attempts Complete: 10 14 24 Messages Complete:  10 8 18
Total Outcall Time: 234 349 583 Total Message Time: 325 113 438
Failed (Busy): 2 0 2 Failed (No Answer): 1 2 3
*** End of Report ***
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Line Statistics

The Line Statistics displays call information for each system port.
This report cannot be saved to disk. It must be directed to a printer.
The report contains the following information:

• Port–Displays the port number.

• Calls–Displays the number of incoming calls to the port handled
by the system.

• Fails–Displays the number of outbound calls initiated from the
port to destinations that were either busy or not answered.

• Avg. Len–Displays the average length of each call in seconds to
or from the port.

• Dials–Displays the number of outbound calls placed by the
system such as wake-up call or to light a message waiting light.

• Connects–Displays the number of outgoing calls generated by
the system that connected successfully. This number is smaller
for systems using unsupervised message waiting lights than for
system s using supervised message waiting lights.

PORT STATISTICS 11/01/98     11:38 AM                 Page 1

Port Calls Fails AvgLen Dials Connects
0 359 8 34 80 72
1 68 3 45 10 7
2 55 2 33 4 2
3 10 0 29 80 80
TOTAL 492 13 141 174 161
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Application Statistics

The Application Statistics report displays call statistics for the
inbound and outbound ports specified in System Setup. The first
application number represents Inbound ports. The second application
number represents Outbound ports. This report displays the following
information:

• Appl.–Displays the number of the application for which the
statistics are recorded.

• Calls–Displays the total number of calls for the application.

• Fails–Displays the number of outbound calls initiated from the
port to destinations that were either busy or not answered.

• Dials–Displays the number of outgoing calls for the application
generated by the system such as wake-up calls or calls made to
light a message waiting light.

APPLICATION STATISTICS 11/01/98     10:45 AM  Page 1

Appl. Calls Fails Dials
1 3457 7 2081
2 0 0 0

Hourly Statistics

The Hourly Statistics report monitors the total number of incoming
and outgoing calls for each hour of both the current and previous
day. This report cannot be saved to disk. It must be directed to a
printer. This report contains the following information:

• Today/Yesterday columns–Displays the hour of the day for
which the statistics are recorded for the current or previous day.

• Calls–Displays the number of incoming calls handled by the
system.

• Fails–Displays the number of outbound calls initiated from the
port to destinations that were either busy or not answered.
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• Dials–Displays the number of outgoing calls placed by the
system for wake-up calls or to light message waiting lights.

HOURLY STATISTICS    11/01/98   10:13 AM    Page 1

TODAY: Calls Fails Dials
12 AM 11 0 0
1 AM 3 0 0
2 AM 0 0 0
3 AM 0 0 0
4 AM 0 0 0
5 AM 4 0 0
6 AM 15 0 0
7 AM 20 0 2
8 AM 42 0 3
9 AM 60 0 23
10 AM 55 0 14
11 AM 57 0 18
12 N 71 2 22
1 PM 68 0 43
2 PM 80 0 21
3 PM 70 0 13
4 PM 35 0 15
5 PM 20 0 8
6 PM 28 1 1
7 PM 20 0 0
8 PM 21 0 3
9 PM 15 0 0
10 PM 0 0 0
11 PM 8 0 0
Total: 703 3 182

YESTERDAY: Calls Fails Dials
12 AM 9 0 0
1 AM 3 0 0
2 AM 0 0 0
3 AM 0 0 0
4 AM 0 0 0
5 AM 3 2 0
6 AM 13 0 1
7 AM 17 0 2
8 AM 38 0 3
9 AM 54 0 9
10 AM 56 0 21
11 AM 50 0 17

12 N 66 1 12
1 PM 64 0 32
2 PM 72 0 27
3 PM 65 1 41
4 PM 30 0 11
5 PM 24 0 14
6 PM 21 1 1
7 PM 18 0 0
8 PM 17 2 3
9 PM 16 0 0
10 PM 0 0 0
11 PM 8 0 0
Total: 644 7 192
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Notes:
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C H A P T E R  6

The Display Menu

The Display menu offers 8 different options you can select to view
system status and statistics.
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A check mark next to a display name means the display is active. A
stack of dashes means a display is active but hidden.

Mailbox Status

The Mailbox Status screen shows the number of both new and saved
messages for each mailbox. Mailboxes containing new messages
are highlighted and flashing. The maximum total that can be
displayed for each type of message is 99.

The Next and Previous buttons allow you to advance or return to
screens containing additional mailbox numbers and their respective
status information.
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To quickly find a mailbox on a large system, select Start New Search,
type the mailbox number, and select <OK>. If the mailbox number
you entered exists, it will be the first entry listed in the first column.

You can view information for a particular mailbox by using the arrow
keys to highlight the mailbox, then pressing <ENTER>. The Mailbox
Information dialog box that displays contains the mailbox number,
extension, mailbox owner’s name, company, division, and the
number of new and saved messages. Select OK to close the dialog
box.

To close the Mailbox Status display, select Exit.

Channel Status

Channel Status displays call activity on each of the first four installed
ports. If your system has less than four ports, only those ports are
displayed. If your system has more than four ports, you must select
the Next Channel Status option to view their activity.

Channel Status displays “Waiting for ring...” or “Waiting for DID...” if a
channel is not occupied by a call. Once a call occupies a port, you
can monitor the caller’s actions on the screen. It is recommended
that this display be active to monitor calls.
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Command Line

The Command Line Interface allows you to enter commands to
perform certain tasks and functions from the command line. The
tasks and functions you can perform from the command line include
disabling, enabling, and dropping ports; altering the system’s date
and time; and performing a system shutdown. For a complete list of
available commands, see Chapter 9, ”Operator Commands.”
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Next Channel Status

Since only four ports can be displayed at one time on the Channel
Status screen, you can use Next Channel Status to display the status
of additional installed ports. Each time you select Next Channel
Status, the next four ports are displayed. When you reach the last
four ports on the system, you can select Next Channel Status again
to redisplay the first four ports.

Calls Per Hour

The Calls Per Hour display monitors the total number of incoming
calls per hour for both the current and the previous days.
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The bars on the left side of the display represent the current day’s
call activity, while the bars on the right side of the display represent
the previous day’s call activity. Bars are labeled M (Midnight), 6 (600
AM), N (Noon), and 6 (6:00 PM). The highlighted bar represents the
current hour.

System Usage

The System Usage graph displays the percentage of total available
system time used during a certain hour. A 4-port system has 240
minutes of available system time each hour (4 ports x 60 minutes
each). If the ports were used a total of 80 minutes during a particular
hour (for example, 32 minutes on port 0, 25 minutes on port 1, 15
minutes on port 2, and eight minutes on port 3), then the system
used 80 minutes of an available 240 minutes, for a usage percentage
of 33% for that hour.

The bars on the left side of the display represent the current day’s
call activity, while the bars on the right side of the display represent
the previous day’s call activity. Bars are labeled M (Midnight), 6 (6:00
AM), N (Noon), and 6 (6:00 PM). The highlighted bar represents the
current hour.
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50% Contention

The 50% Contention graph displays the percentage of a specific hour
that half (50%) of the system’s ports were simultaneously occupied. If
a system has four installed ports, and any two of those ports were
occupied at the same time for 15 minutes of a given hour, then that
hour had 50% contention 25% (15/60ths) of the hour.

The bars on the left side of the display represent the current day’s
call activity, while the bars on the right side of the display represent
the previous day’s call activity. Bars are labeled M (Midnight), 6 (6:00
AM), N (Noon), and 6 (6:00 PM). The bar that is highlighted represents
the current hour.
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100% Contention

The 100% Contention graph displays the percentage of a specific
hour that all (100%) system ports were simultaneously occupied. If a
system has four installed ports, and all four of those ports were
occupied at the same time for three minutes of a given hour, then
that hour had 100% contention 5% (3/60ths) of the hour.

The bars on the left side of the display represent the current day’s
call activity, while the bars on the right side of the display represent
the previous day’s call activity. Bars are labeled M (Midnight), 6 (6:00
AM), N (Noon), and 6 (6:00 PM). The highlighted bar represents the
current hour.

If the percentages on the 100% Contention screen are consistently
between 2 and 5 percent during any particular hour, it is
recommended that more ports installed on your system, since callers
to the system will hear a busy signal when all ports are occupied.
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C H A P T E R  7

The Options Menu

The Options menu contains five selections:

• Greeting by Port

• Class of Service

• AMIS Maintenance

• System Setup

• Screen Configuration
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Greeting By Port

Greeting by port allows you to set up a multiple greeting system by
assigning each company’s calls to be answered by a unique port.
This way Octel 50 can handle calls for an executive office complex
where a group of businesses share one switchboard.

When setting up greetings by ports, consider the following:

• To ensure the appropriate mailboxes are included in the
company directories, and that subscribers can access their
mailboxes, verify the entries in the Company field on the
Mailbox Entry screen are the same for the mailbox assigned
to answer the port and the subscriber mailboxes assigned to
the company. For additional information, see Chapter 3, “The
Mailbox Menu.”

• For the mailbox designated to answer calls to the port, record
the greeting for the port as the Personal Greeting prompt for
the mailbox. You can record this greeting from the
Supervisor’s menu. For additional information, see Chapter
10, “Supervisor Keypad Options.”

• You can block the mailbox to use with a V-Tree. This allows
you to simulate the attendant menu feature in a greeting by
port application. For additional information on creating
V-Trees, see Chapter 11, “V-Trees.”

• Mailboxes with no assigned company on the Mailbox entry
dialog box can access all ports. To allow the system
supervisor access to all ports on the system through the
phone interface, do not enter a Company for the system
supervisor’s mailbox. For additional information, see Chapter
3, “The Mailbox Menu.”
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To configure Greeting by Port:

1. Start Octel 50 if it is not already running and log in as a level 3
supervisor.

2. From the Options menu, select Greeting by Port. The Greeting
by Port dialog box displays.

 
3. In the Port # field, enter the number of the port you want to

configure for greeting by port.

4. To activate the port for greeting by port, select the Active option.

5. Under Mailboxes to use, enter the number of the mailbox you
want to assign to answer the port during business hours in the
During Hours field.

6. Under Mailboxes to use, enter the number of the mailbox you
want to assign to answer the port after business hours in the
After Hours field.  The after hours mailbox you enter may be the
same as the during hours mailbox you entered in step 5.

7. Under Daily Business Hours, click the Sunday button to display a
list of the days of the week.

8. To select the day of the week you want to set hours for, use the
up and down arrows to highlight the day in the list, then press
<ENTER>.
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9. Select one of the following business hours options for the
selected day of the week:

• Open All Day–The time of day greetings (morning,
afternoon, and evening) are voiced at the appropriate times
during the day at the times specified on the Time/Date tab in
System Setup. The office closed greeting is not voiced during
that day.

• Closed All Day–The office closed greeting is voiced during
the whole day. The time of day greetings are not voiced
during that day.

• Selected Hours–The time of day greetings are voiced during
the times specified in the Open and Close fields. The office
closed greeting is voiced the rest of that day.

10. If you chose the Selected Hours option, enter the time of day the
company opens for business and closes in the Open and Close
fields in standard AM/PM format. The closed time must be later
than the open time. During business hours, the personal greeting
from the during-hours mailbox is used. During closed hours, the
personal greeting from the after hours mailbox is voiced to
callers.

11. If you want to configure several consecutive days with the same
daily business hours, select Copy To: under Daily Business
Hours to copy the information to the next day.

12. To save the entered greetings by port information, select Save.

13. To copy the entered information to the next consecutive port
number on the system, select Copy to Port #.

14. To view or modify the greeting by port settings for another port,
select the Next or Prev button.

15. To close the Greeting by Port dialog box, select OK. The Octel
50 main window displays.
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Class of Service

A class of service is a set of features and specifications that are
assigned to a mailbox. The class of service assigned to a mailbox
dictates which features are accessible to the subscriber. When a
feature, such as call screening, is not activated in the class of service
assigned to a mailbox, options relating to the feature are not voiced
when the subscriber accesses the mailbox.

There are 25 predefined classes of services you can assign to a
mailbox. You may also create custom classes of service for individual
mailboxes if you are logged into the system as a level 3 supervisor.
Note that the custom class of service options on the Class of Service
dialog box are not displayed unless you are logged in as a level 3
supervisor on the system. For additional information on custom
classes of service, see Chapter 3, “The Mailbox Menu.”

Even though some features are selected in the mailbox class of
service, you can disable these features in the subscriber settings for
the mailbox, preventing the subscriber from using the features. You
can also enable features in the subscriber settings that are not
selected in the mailbox’s class of service. This enables you to control
an individual subscriber’s use of certain mailbox features without
creating a custom class of service.

To view or modify a predefined class of service:

1. From the Options menu, select Class of Service. The Class of
Service dialog box displays.
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2. In the Class of Service field, enter the number of the class of
service you want to view or modify, or use the Prev and Next
buttons to view the available classes of service.

3. Modify the class of service settings you want to change. Note
that changes made to a predefined class of service apply to any
mailbox assigned that class of service number.

4. To save the changes, select Accept. The Octel 50 main screen
displays.

The following options are available on the Class of Service dialog
box.

Call Screening
Call Screening allows a subscriber to accept, reject, or redirect a call.
When call screening is activated, the system instructs callers
requesting that extension to record their names at the tone. If the
subscriber wants to take the call, the subscriber presses <#>, and
the caller is transferred to the extension. If the subscriber wants to
reject the call, the subscriber presses <1> and immediately hangs up
the phone. If a call is rejected by the subscriber, the caller is told
there was no answer at the extension and is given the choice of
trying another extension, leaving a voice mail message, or dialing the
operator’s extension. The caller is not given the option to page. The
subscriber may also choose to redirect the call by pressing <*>,
followed by the destination mailbox number. The subscriber must
then immediately hang up the phone so the caller can be transferred
to the specified extension.

If you want to prohibit subscribers from changing the call screening
for their mailbox, do not select the Call Screening option in the
mailbox’s class of service, and instead select the Call Screening
option in the mailbox’s subscriber settings.

Confirmation
Confirmation allows the subscriber to review the date and time a
message was sent, to whom it was sent, and, if applicable, the date
and time the recipient listened to or skipped the message. This
feature helps the sender of a message determine if and when
another subscriber received the message. This feature is not
supported by the AMIS protocol—only messages sent to local
subscribers may be sent with confirmation.
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Voice Folders
Voice Folders allow a subscriber to organize voice and fax messages
by storing them in “folders” in the mailbox. A subscriber can create
up to nine folders to store messages. The subscriber records a label
for each folder, which is voiced when the subscriber accesses the
mailbox. For example, if a subscriber regularly receives messages
that are either technical or administrative, the subscriber can create
two folders with the labels “Technical” and “Administration” to save
and organize the messages.

Call Queuing
Call Queuing allows callers to either hold for a specific extension or
leave a voice message when the dialed extension is busy. Depending
on the how call queuing is set up on the system, callers may be
informed of their status in the queue, including their position (the
number of calls ahead of them), while they hold for that extension.
Call queuing may also give callers periodic opportunities to either
leave a voice message or continue to hold. The caller on hold may be
provided with prerecorded music or messages, such as product
information.

You may record up to nine verbal or music messages for callers to
listen to while holding in the queue. For example, the messages
could provide new product information or sales promotions to callers
in the queue. The system voices each of the nine messages to each
caller in the queue. After voicing each recorded message, the system
voices the caller’s status followed by the available options. Once the
system plays all the recorded messages, it returns to the first
message and begins voicing the messages again. All mailboxes on a
system that have call queuing activated in the class of service use
the same nine prompts. The first caller in the queue hears a prompt
before the call is transferred to the extension. For information on
specifying and using the call queuing prompts, see Chapter 4, “The
Attendant Menu.”

If you want to prohibit subscribers from changing the call queuing for
their mailbox, do not select the Call Queuing option in the mailbox’s
class of service, and instead, select the Call Queuing option in the
mailbox’s subscriber settings.
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Message Light
Message Light allows you to use the light or LEDs on subscriber’s
phones to notify them of new messages in their mailboxes. Once a
subscriber listens to or skips a message in a mailbox, the message
waiting light on the phone is turned off. Note that message waiting
lights only work if the phone system supports the feature and the
system has been set up to use the message waiting lights.

Intercom Paging
Intercom Paging allows a caller to page a subscriber who does not
answer the mailbox extension. A paged subscriber can either retrieve
the call from the subscriber’s extension or use the intercom redirect
feature to access the call from another extension by rerouting the
call. If the subscriber does not respond to the page, the caller is given
the option to try another extension, leave a voice message in the
subscriber’s mailbox, or transfer to the operator. If the caller retries to
call the original extension, the system waits approximately one
minute before redialing that extension.

Paging may be set to Off, On, or Automatic. When paging is off,
callers cannot page subscribers. When paging is on, the caller is
given the option to page when there is no answer at the subscriber’s
extension. When paging is set to automatic, the subscriber is always
paged once before the system performs the call handling options that
are set up for the mailbox.

If you want to prohibit subscribers from changing the selected
Intercom Paging option for their mailbox, do not select the Intercom
Paging option in the mailbox’s class of service, and instead, select
the appropriate intercom paging option in the mailbox’s subscriber
settings.

Paging is available only if an intercom is connected to the phone
system and the intercom paging feature has been set up on the
system.

Distribution List
Distribution List allows subscribers to create lists of mailboxes, so
one message can be sent to multiple recipients in one step. For
example, a subscriber can create a group list of all subscribers
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working on a particular project. The subscriber can then send a
message to all subscribers on the project by entering a single
number. Subscribers can create up to 10 distribution lists in their
mailboxes, numbered *0 through *9. Each list can contain a total of
20 mailboxes, personal network addresses, or other distribution list
numbers. Each distribution list included as a destination on a
personal group list counts as one destination. To include destinations
on other voice mail systems, the subscriber must also be permitted
access to network message features in the mailbox’s class of
service.

Personal Network Address—A personal network address consists
of one entry containing the access phone number of a remote system
that supports the AMIS protocol and a mailbox number at that
location. The subscriber must have Casual AIM dispatch options, as
well as access to distribution lists, to use personal network
addresses. A subscriber can record up to 20 individual personal
network addresses, numbered *20 through *39.  A personal network
address is a convenient way of using Casual AIM features without
having to dial a long series of digits. You can also incorporate a
personal network address as an entry in a distribution list.

Global Distribution
Global Distribution allows the subscriber to send messages to system
distribution lists *10 through *19 and global lists *98 and *99. Lists
*10 through *19 must be created by a supervisor using the phone;
*98 and *99 are system-generated lists containing all mailboxes in a
subscriber’s division and company, respectively. Subscribers cannot
include system distribution lists in their own personal lists unless this
option has been chosen for their mailboxes’ class of service.

Directory Access
Directory Access allows subscribers to access a listing of all
subscribers and their mailbox numbers. This allows subscribers to
send messages to other subscribers without requiring them to know
the subscriber’s mailbox number.

In some instances, subscribers may belong to a voice mail service
bureau, where they would not need to know the mailbox numbers of
other system subscribers. If the system is set up to use greeting by
port, only mailboxes with the same company are voiced in a
directory.
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Call Handling
Call Handling allows subscribers to control how calls to their
mailboxes are routed. For example, a subscriber can set up a
mailbox to block all calls to a prompt that requests the caller to leave
a message while the subscriber is on vacation. The mailbox can be
set up to voice an optional prompt, forward the call to another
extension, or route the call to a V-Tree. The mailbox can also be set
up to perform one of these actions for either all calls to the mailbox,
calls that are not answered, or calls that receive a busy signal. For
additional information, see Chapter 3, “The Mailbox Menu.”

If you want to prohibit subscribers from changing the selected Call
Handling option for their mailbox, do not select the Call Handling
option in the mailbox’s class of service, and instead, select the
appropriate call handling option in the mailbox’s subscriber settings.
This is especially useful when mailboxes are blocked to V-Trees
because it prevents the feature from being accidentally deactivated
by a subscriber.

V-Tree
V-Tree allows subscribers to create custom voice menus in their
mailboxes. V-Trees can route calls, provide information to callers, or
collect information from callers. For example, a mailbox for a sales
department can contain a V-Tree that allows callers to press <1> for
information on product A, press <2> for information on product B, or
press <3> to talk to a sales representative. For additional information,
see Chapter 11, “V-Trees.”

If you want to prohibit subscribers from changing the selected V-Tree
options for their mailbox, do not select the V-Tree option in the
mailbox’s class of service, and instead, select the appropriate V-Tree
options in the mailbox’s subscriber settings.

Fax V-Tree
Fax V-Tree allows subscribers to create V-Trees in their mailboxes
that have fax options. For example, a mailbox for a sales department
can contain a V-Tree that allows callers to press <1> for information
on product A, press <2> for information on product B, press <3> to
talk to a sales representative, or press <4> to have information on all
products faxed to them. Note that the system must have the Fax
Solution module set up, and have both the Fax V-Tree and V-Tree
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options selected in the mailbox’s class of service to allow the
subscriber to include fax features in a V-Tree.

Send Message
Send Message allows subscribers to send messages from their
mailboxes to other system subscribers or subscribers on other voice
mail systems, if AMIS is set up for the system.

Receive Message
Receive Message allows a subscriber to receive messages from both
subscribers and outside callers (non-subscribers). When both this
feature is selected and the system is set up to receive messages
from other voice mail systems, subscribers can receive messages
from remote subscribers whose voice mail systems support AMIS.

Save Messages
Save Messages allows subscribers to save messages sent to their
mailboxes. The values entered in the Days to Save section of the
Class of Service dialog box determine how long the mailbox
subscriber can save a messages in the mailbox before the system
deletes them.

Undelete Messages
Undelete Messages allows subscribers to recover either new or
saved messages deleted from their mailboxes. This feature helps
prevent subscribers from accidentally deleting a message in the
mailbox. Subscribers can only undelete the messages that they
deleted during the current session. Once a subscriber exits a mailbox
by hanging up or backing out of the mailbox, the messages are
permanently deleted.

Message Scan
Message Scan allows subscribers to scan their new messages for
messages sent from a particular subscriber. This feature only allows
subscribers to scan for a message from another subscriber on the
system. Subscribers cannot locate messages from another voice
mail system or an outside caller.
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Sent Message Editing
Sent Message Editing allows subscribers to search for and edit
messages they have already sent from their mailboxes to other
mailboxes that are still in the mailbox’s new message queue.
Subscribers can only use this feature to locate and edit messages
sent to other subscribers on the system. Messages designated for
AMIS dispatch to other voice mail systems cannot be edited.

Record Prompts
Record Prompts allows mailbox subscribers to record their own
mailbox prompts: Please Hold prompt, Directory prompt, Name
prompt, Personal Greeting prompt, Optional 1 prompt, and Optional 2
prompt. If prompts are not recorded for a mailbox, the system default
prompts are used. It is recommended that subscribers be allowed to
record their own prompts to add a personal touch to the system.

Operator Access
Operator Access allows callers to the mailbox to transfer to the
mailbox’s operator. This operator can be the default operator set up
for the system or a personal operator specified on the Mailbox Entry
dialog box.

Supervisor
This option allows the subscriber to access the Supervisor Main
menu over the phone. A supervisor has access to many functions,
including the ability to create, edit, and delete mailboxes; record
system and personal prompts; and maintain system distribution lists.
Although Octel 50 allows any number of supervisors, there should
only be a few. If there are multiple companies, there should be one
supervisor for each, since a supervisor can only edit mailboxes with
the same company. For additional information, see Chapter 10,
“Supervisor Keypad Options.”

Message Delivery
Message Delivery box controls whether subscribers can use the
message delivery and wake-up call features, whether they can enter
local and long distance numbers, and the type of calls that are
considered successful delivery attempts.
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Not Allowed
Not Allowed does not permit subscribers to use the message delivery
and wake-up call features.

Local Delivery Only
Local Delivery Only allows subscribers to only enter numbers defined
as local numbers. The number of characters a subscriber can enter
for a local number is limited by values entered during the set up of
the system.

You can manually enter a long distance number for a mailbox feature
even though the mailbox has Local Only selected as a delivery
option. This allows you to specify which features the mailbox can use
to call long distance numbers. To manually enter a long distance
number for a feature, enter the long distance number, up to 16
characters, in the mailbox’s subscriber settings. The subscriber
cannot change this number in the mailbox after it is entered in the
subscriber settings.

Long Distance
Long Distance allows subscribers to enter up to 16 characters to call
numbers for the message delivery and wake-up call features.

Batch Mode
Batch Mode, if selected, specifies that when the system performs
message delivery, it considers the subscriber successfully notified of
the message when either someone or something, such as an
answering machine, answers the phone. For example, if the system
calls the number specified for message delivery and an answering
machine answers the call, the system interprets the attempt as
successful and does not attempt to notify the subscriber again.

If the Batch Mode option is not selected, the system interprets a
message delivery attempt successful when the subscriber logs into
the mailbox.

The batch mode feature does not affect message delivery through a
beeper. Batch mode is only used with message delivery and has no
effect on the wake-up calls feature.
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Fax
Fax options allows subscribers to use the Fax Solution module, if
installed on the system. The module allows subscribers to send and
receive faxes in their mailboxes.

Send Faxes
Send Faxes allows subscribers to send fax messages, including
copies of voice/fax messages, from their mailboxes to other system
subscribers. Note that the Fax Solution module must be set up on the
system to use this feature.

Faxes cannot be sent to other voice mail systems. If a fax message
is sent to a group list that contains both local subscribers and
network destinations, only the local subscribers who are permitted to
receive faxes receive the attached fax message. Recipients at the
remote system only receive the voice portion of the message.

The Send Faxes option must be selected for subscribers to include
fax capabilities in V-Trees they create for their mailboxes.

Receive Faxes
Receive Faxes allows subscribers to receive fax messages in their
mailboxes from both subscribers and outside callers. Note that the
Fax Solution module must be set up on the system to use this
feature.

Max Messages
Max Messages defines the maximum number of messages (both
new and saved) permitted in the mailbox. This feature helps manage
the system’s available disk space by limiting the amount of space
mailbox messages can take up on the system. The functions of the
mailbox should be considered when setting this value. For example,
you may want to allow the sales department mailboxes to store more
messages than mailboxes in other departments. Ensure that the
operators’ mailboxes are able to store enough messages to allow for
high call volume. The maximum number of messages a mailbox can
contain is 32,000. The recommended Max Messages value is under
70.
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Msg Time
Msg Time defines the maximum length (in seconds) allowed for the
following types of messages:

• Messages that subscribers record to send to other
subscribers

• Messages sent from other voice mail systems

• Messages sent to mailboxes from outside callers

This feature helps to manage the system’s available disk space by
limiting the amount of space mailbox messages can take up on the
system. The functions of the mailbox should be considered when
setting this value. For example, a customer service department may
require a longer message time than an accounting department. The
minimum message length is 30 seconds; the maximum message
length is 32,000 seconds. If AMIS messaging is permitted, this value
should be set to no more than 480 seconds (8 minutes) to
accommodate the maximum AMIS message time.

Total Time
Total Time limits the total message time allowed. This feature helps
to manage the system’s available disk space by limiting the amount
of space mailbox messages can take up on the system. If Total Time
is left blank or set to 0, the total time allowed for recording is
determined by multiplying the Max Messages value by the Msg Time
value.

Language
Language allows you to select the mailbox’s default language. Octel
50 can support as many as five languages, numbered 1 through 5.
Language 1 defaults to English. If you would like to use another
language on the system, you must specify multiple languages in
System Setup and recorded the phrase script in that language.

Days to Save New Messages
This field specifies the number of days a message that has not been
listened to can remain in the mailbox before it is automatically
deleted by the system. To keep messages in the mailbox until they
are either saved or deleted, enter 99. The system can also be set up
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to notify mailbox subscribers that a message has been deleted from
their mailbox by the system.

Days to Save Saved Messages
This field specifies the total number of days that a message can
remain in the mailbox before it is automatically deleted by the system.
The total number of days a message has been in a mailbox starts as
soon as the mailbox receives the message. For example, if this field
is set to 14 days and a message was sent to the mailbox 4 days ago,
it will only be saved for 10 more days, even though it was listened to
and saved by the subscriber after 2 days. To save messages
indefinitely, enter 99. The system can also be set up to notify mailbox
subscribers that a message has been deleted from their mailbox by
the system.

Maximum Rings
Maximum Rings specifies the number of rings before the system
determines there is no answer at a mailbox’s extension.

The number entered in Maximum Rings overrides the value set in the
Maximum Rings before No Answer parameter in System Setup.

If you enter a 0, call progress is not used for this extension, and the
system transfers and releases the call without testing for a busy or no
answer condition (blind transfer). In this event, if there is no answer
or if the mailbox is busy, the call will not go back to the messaging
system unless an integration feature is being used on the system, or
the phone itself is forwarded to the voice mail extension.

Ensure this number is at least 1 less than the number of rings set up
on the system’s telephone switch. If the number is not at least 1 less
than the number of rings set up for the switch, calls are not routed to
the Octel 50 system.

It is recommended that you do not set the ring count to less than 3, or
more than 15. The system may not recognize less than 3 rings on
some telephone switches, and more than 15 rings may produce
unpredictable results.
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AMIS Class of Service
If the class of service has Send Message enabled and the system is
configured with the AMIS Interface Module (AIM), you can select the
AMIS button on the Class of Service dialog box to configure AMIS for
the class of service.

Highest Outgoing Dispatch
Highest Outgoing Dispatch defines the how messages are sent from
the mailbox:

• Not Allowed–The subscriber does not have AIM message
dispatch options.

• Economy–The subscriber only has the Economy dispatch
option. Messages dispatched by the subscriber will be sent
during the economy hours set up for the system. You can
override the economy hours for individual network nodes if
appropriate.

• Standard– Allows subscribers to send messages marked with
either economy or standard dispatch. Messages sent to other
voice mail systems with standard dispatch are held in a queue
for the maximum time set up for the system or until a defined
number of messages accumulate in the same queue, whichever
occurs first. The holding queue is specific to the remote access
phone number, meaning a message dispatched to node 1 is
held in a separate queue then a message dispatched to node 2.

• Priority– Allows subscribers to send messages marked with
economy, standard, or priority dispatch. A message dispatched
priority is sent to the remote address at the system’s earliest
opportunity. A subscriber’s highest outgoing dispatch option
must be set for priority for the subscriber to be permitted future
delivery of AMIS messages.
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Casual
Casual AMIS allows subscribers to send messages to other voice
mail systems that support the AMIS protocol by entering the
complete phone number of the system and the destination mailbox
number.

If a subscriber is only given casual access, then the subscriber can
only dispatch messages to addresses the subscriber manually
enters.

Reply
If Reply is enabled, the subscriber is permitted to reply to AMIS
messages. Since the system stores the address of the remote
delivery site, the subscriber is not required to enter the remote
access telephone number and mailbox number of the recipient.

Administered
Administered AMIS allows subscribers to send messages to defined
AMIS nodes. Nodes allow subscribers to enter a short series of digits
that represent the complete phone number of another voice mail
system, instead of entering the entire phone number. If Administered
is the only AMIS activated, the subscriber can only send messages to
sites designated as AMIS nodes.

Maximum Message Length
The Maximum Message Length field denotes the maximum length, in
seconds, of each outgoing AMIS message.

Select Accept to save the settings and return to the class of service
dialog box.

AMIS Maintenance

AMIS Maintenance allows you to edit, create, delete, or search for an
administered node. A node represents a remote system that supports
the AMIS-analog protocol.
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Create a Node
You can create AMIS nodes that allow the system to communicate
with other voice mail systems that support the AMIS protocol.

To create a node:

1. From the Options menu, select AMIS Maintenance. The Select
Node dialog box displays.

 

2. In the Enter Node # field, enter the number of the node to create,
then select Create. The AMIS Node Entry dialog box displays the
node number in the Node Number field.

 

3. To allow subscribers to use the node to send messages, select
the Node Active option. This option enables you to easily turn a
node on or off without deleting the node. When you turn the node
off, subscribers cannot send messages to the other voice mail
system through the node and all messages that were scheduled
to be sent to that system are returned to the message sender
with an appropriate message.

4. If the node number includes the first number or numbers used for
all the mailbox numbers on the other voice mail system, enter the
number of digits from the left before the common mailbox
number(s) in the Insignificant Digits field. For example, if all
mailboxes begin with a 7 and the node number is 347, enter 2 in
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the Insignificant Digits field to specify that the 7 in the node
number is part of the mailbox number.

5. In the Tele Access # field, enter the number, up to 16 digits, to
dial for the other voice mail system. Note that this number must
be unique on the system. Two AMIS nodes cannot be set up to
dial the same phone number.

The access phone number must include the country code, area
code, and local number of the other voice mail system. For
example, to create a node that has 1 for the country code, 941 as
the area code, and 555-1234 for the local number, you must
enter 19415551234 in the Tele Access # field.

6. If there is an internal telephone network that allows users to call
extensions on the other voice mail system, enter the internal
telephone network prefix for that location in the Prefix Code field.
If there is not an internal telephone network set up for the other
voice mail system, do not change the default for the Prefix Code
field. The prefix you enter can be up to three characters long.

7. In the System Name field, enter the name of the other voice mail
system, up to 26 characters. The system name is used to help
locate a specific node using the search feature. If the system
name is left blank, the telephone access number is used for the
system name.

8. In the System Prompt field, enter the number of the prompt that
voices the name of the remote system. This prompt is used as a
confirmation of a node number and mailbox entry, if a dispatched
message could not be delivered, and to denote a new message
from a recognized node. For information on recording prompts,
see Chapter 10, “Supervisor Keypad Options.”

9. Under System Administrator Information, in the First Name field,
enter the first name of the person responsible for maintaining the
other voice mail system.

The System Administrator Information is for your information
only. By entering the appropriate information, you can keep
record of the person responsible for maintaining the other voice
mail system.



The Options Menu AMIS Maintenance

OCTEL 50 SUPERVISOR’S GUIDE 7-21

10. Under System Administrator Information, in the Last Name field,
enter the last name of the person responsible for maintaining the
other voice mail system.

11. Under System Administrator Information, in the Mailbox ID field,
enter the mailbox number of the person responsible for
maintaining the other voice mail system.

The Standard Dispatch and Economy Dispatch options allow you
to override the dispatch options specified in System Setup.

12. In the Maximum Messages field, enter the number of messages
that should be marked for dispatch to this node before the
system sends all the messages to the node. This allows the
system to send multiple messages at one time, reducing long
distance fees.

13. In the Maximum Delay field, enter the number of minutes that
should be marked for dispatch to this node before the system
sends all the messages to the node. This allows you to set a
maximum time limit on how long a message can wait before it is
sent to the other voice mail system.

All messages marked for standard dispatch through a node are
sent when either the maximum number of messages is reached
or the first message marked for dispatch exceeds the maximum
delay value, whichever occurs first.

14. Under Economy Dispatch, in the Weekday On field, enter the
time of day to begin the economy dispatch for weekdays.
Economy dispatch options allow you to specify the time when it is
most economical to send messages to other voice mail systems,
based on long distance fees.

15. Under Economy Dispatch, in the Weekday Off field, enter the
time of day to end the economy dispatch for weekdays.

16. Under Economy Dispatch, in the Weekend On field, enter the
time of day to begin economy dispatch on weekends.

17. Under Economy Dispatch, in the Weekend Off field, enter the
time of day to end the economy dispatch on weekends.
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If a weekday time frame extends past midnight, the economy
dispatch extends to that time on Saturday morning. This also
applies if the weekend time frame extends past midnight. The
economy dispatch then extends into Monday morning.

18. To save the node with the entered values, select Save. The
system displays a dialog box to notify you that the node has been
successfully saved.

19. To close the dialog box, select OK. The AMIS Node Entry dialog
box displays.

20. To create another node, select Create, then when the Select
Node dialog box displays, follow steps 2-19.

21. To view other nodes, select Previous or Next.

22. To close the dialog box, select OK. The main window displays.

Edit a Node
Use this procedure to view and edit node information. The
information entered for a node specifies how a subscriber can send
messages to the voice mail system connected through the node.

To edit a node:

1. From the Options menu, select AMIS Maintenance. The Select
Node dialog box displays.

2. In the Enter Node # field, enter the number of the node you want
to edit, then select Edit. The AMIS Node Entry dialog box
displays. If you do not know the node number, use the search
feature to help locate the appropriate node. For additional
information, see the topic, “Search for a Node,” later in this
chapter.

3. Make the changes to the node information. For additional
information on specific fields, see the topic, “Create a Node,”
earlier in this chapter.

4. To save the changes, select Save. The system displays a dialog
box to notify you that the node has been successfully saved.
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5. To close the dialog box, select OK. The AMIS Node Entry dialog
box displays.

6. To close the AMIS Node Entry dialog box, select OK. The Octel
50 main window displays.

Delete a Node
Use this procedure to delete a node from the system. Note that you
can also simply deactivate a node without deleting it. Deactivating a
node prevents subscribers from sending messages to that voice mail
system through the node until you reactivate the node.

To delete a node:

1. From the Options menu, select AMIS Maintenance. The Select
Node dialog box displays.

2. In the Enter Node # field, enter the number of the node you want
to delete, then select Delete. A deletion confirmation dialog box
displays. If you do not know the node number, use the search
feature to help locate the appropriate node. For additional
information, see the topic, “Search for a Node,” later in this
chapter.

 

3. To confirm that you want to delete the node, select Yes. The
system displays a message to notify you that the node is
checked.

4. Select OK. The Select Node dialog box displays.

5. To close the dialog box, select Cancel. The Octel 50 main screen
displays.

You can also select Delete on the AMIS Node Entry dialog box to
delete the current node. If you delete a node from the AMIS Node
Entry dialog box, the AMIS Node Entry dialog box displays the next
node numerically after the node is deleted.
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If you delete the only node on the system, the system displays the
message “All Nodes have been Deleted” after it notifies you of the
node deletion. Select OK to close the dialog box. The Octel 50 main
screen displays.

Search for a Node
Use this procedure to locate a node by the system name. Depending
on how you access the search feature, you can view, edit, or delete a
node after locating it.

To search for a node:

1. To search for a node, do one of the following:

• From the Options menu, select AMIS Maintenance, then
when the Select Node dialog box displays, select Search.

• From the AMIS Node Entry dialog box, select Search.

 The AMIS Node Search dialog box displays all of the nodes
alphabetically by system name.

2. Use the up and down arrow keys to move through the list of
nodes.

3. To search for a node by entering the system name, enter the
name to search for in the Target field, then select Begin New
Search. The system displays the node name at the top of the list
if a match was found. If a match of the name was not found, the
next closest name alphabetically displays.

4. When the selected node is highlighted, select OK to select the
node. If you searched for a node from the Select Node dialog
box, the node number displays in the Enter Node # field. If you
searched for a node from the AMIS Node Entry dialog box, the
node information displays.



The Options Menu System Setup

OCTEL 50 SUPERVISOR’S GUIDE 7-25

System Setup

System Setup allows you to customize the parameters that control
the automated attendant and voice mail features available on the
system, as well as control the technical aspects of the system. It is
available to supervisors with level 3 security access only.

When you select System Setup from the Options menu, the System
Setup dialog box displays.

Change System Setup
Select Change System Setup to modify the current System Setup
parameter settings. If you need to modify the settings in System
Setup, contact a technical support representative.

Save System Setup
Select Save System Setup to accept any changes you have made to
System Setup parameters.

Print System Setup
Select Print System Setup to obtain a hard copy of the System Setup
parameter settings. Make sure that the Octel 50 PC is connected to a
printer before you select this option.

Set to Defaults
Select Set to Defaults to return System Setup parameters settings to
the system default values. Do not select this option unless advised to
by a technical support representative.
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Exit
Select Exit to close the System Setup dialog box. The Octel 50 main
screen displays.

Screen Configuration

The Screen Configuration option allows you to modify the Octel 50
display options. When you select Screen Configuration, the
Configure Screens dialog box displays.

Change Colors
Change Colors allows you to customize the colors on the system
screens. You can change the color selections for many screen areas,
including windows, menus, error text, graph bars, and scroll bars.

To change the screen colors:

1. From the Options menu, select Screen Configuration. The
Configure Screens dialog box displays.
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2. Select Change Color. The System Color dialog box displays.

3. Press <TAB> to highlight the list of screen areas you can change
(Buttons, Input Field, etc.)  A check appears next to the active
screen area.

4. Use the up and down arrow keys to highlight the area you want to
change.

5. Press <SPACEBAR> to select the area as the active area. The
current text and background colors display in the Sample box.

6. Press <TAB> to move to the Text box. A check appears next to
the current text color for the active area.

7. To change the text color, use the up and down arrow keys to
highlight the new text color you want to assign, then press
<SPACEBAR>. A check appears next to the new text color, and
the Sample box changes to reflect the new color.

8. Press <TAB> to move to the Background box. A check appears
next to the current background color for the active area.

9. To change the background color, use the up and down arrow
keys to highlight the new background color you want to assign,
then press <SPACEBAR>. A check appears next to the new
background color, and the Sample box changes to reflect the
new color.

10. To accept the screen changes, select Save. The Octel 50 main
screen displays. To return the colors to the system defaults,
select Defaults.
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Save Screen Layout
Select Save Screen Layout to permanently retain the system screen
setup modifications made during the session.

Set to Defaults
Select Set to Defaults to return all screen settings to their original
defaults.

Exit
Select Exit to close the System Color dialog box. The Octel 50 main
screen displays.
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The Help Menu

This section discusses the help screens that are available in Octel
50.



The Help Menu The Help Screens

Octel 50 Supervisor’s Guide 8-2

The Help Screens

You can easily access help screens to learn more about many of
Octel 50’s options and features. These screens contain detailed
information on system capabilities and explain how many of the
features relate to one another.

When you select Help from the Help menu on the Octel 50 main
screen, the Help Index Window by Name dialog box displays.

This dialog box lists the available help topics. To view a help topic,
use the up and down arrows or select Page Up or Page Dn to locate
and highlight the topic, then press <ENTER>. The help topic screen
displays. To return to the help index, select Ok, or press the <ESC>
or <SPACEBAR> key.

You can access help directly on individual topics directly from Octel
50 screens. To view a help screen on a specific item, highlight the
button or field, then press <F1>. For example, to view information
about the Logoff option located on the File menu, highlight Logoff,
then press <F1>.
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When you finish reading the help screen, click Ok, or press the
<ESC> or <SPACEBAR> key to return to the Octel 50 screen from
which you activated help.

You can also access the help index from Octel 50 screens by
highlighting a field or button, then pressing <SHIFT+F1>.

On some help screens, you can access information on related topics
by clicking on function buttons that may be provided.

 

For example, when you access help on the Mailbox menu, you can
access additional help screens on Creating a Mailbox, Editing a
Mailbox, Deleting a Mailbox, and Clearing a Mailbox. To go to one of
these screens, click the item you want to read more about, or use the
<TAB> and <SHIFT+TAB> or up and down arrow keys to highlight
the item then press <ENTER>.
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Notes:
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Operator Commands

You can enter a number of commands for system operation using the
Octel 50 Command Line Interface.
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Open and Close the Command Line Interface

To open the command line interface, select Command Line from the
Display menu. The Command Line interface screen displays.    

To close the command line interface, reselect Command Line from
the Display menu.

You must press <ENTER> after each of the following commands.

CLOSED–Office Closed

Purpose: Instructs the system to immediately terminate any active
business hours.

Syntax: CLOSED

The system resets at midnight to normal hours.

CLRPRT–Clear Printer

Purpose: Instructs the system to reset the printer functions when a
hung condition is determined. The printer may hang due to an
internal printer problem or an undetected system problem.

You may also want to use this command whenever the system
encounters difficulty during a shut down and after all voice ports are
disabled.

Syntax: CLRPRT

CLS–Clear Screen

Purpose: Erases all information, such as error messages, in the
Command Line Interface display area.

Syntax: CLS
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COPY–Copy File

Purpose: Copies a file from one location to another.

Syntax: COPY source_filename target_filename

where source_filename is the filename (including the full path) to
copy from and target_filename (including the full path) is the filename
to copy to.

Example: COPY C:\CVR1\OPERATOR.LOG
A:\OPERATOR.LOG

This example copies the OPERATOR.LOG file from the \CVR1
directory on the C: drive to the A: drive.

Use this command with caution as the system does not check to see
if the filename already exists. This could result in an existing file
being overwritten.

DATE–Specify System Date

Purpose: Sets the system date. The default is the date set by the
operating system on the PC.

Syntax: DATE mmddyyyy

where mm specifies the month, dd specifies the day, and yyyy
specifies the year.

Example: DATE 08301999

In this example, the date is set to August 30, 1999.

DEBUG

Purpose: Turns on Debug mode.

Syntax: DEBUG ON or DEBUG OFF
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DIGRAB–Digit Grabber

Purpose: Allows you to view digits being sent by the switch on the
Command Line Interface display.

Syntax: DIGRAB ON or DIGRAB OFF

DIS–Disable Port(s)

Purpose: Disables all ports or a specific port at the completion of
the current call and prevents further operation on such ports. Ports
can be restored to normal operation using the ENA command. The
DIS command does not shut down the system. Even though all ports
are disabled, Octel 50 will still run. It will not, however, answer
incoming calls.

Syntax: DIS n  or DIS ALL

where n is the port number.

Example: DIS 0

In this example, port 0 is disabled. To free all ports, first use the DIS
command to prevent unoccupied ports from answering further calls,
then use DROP to terminate calls on any occupied lines.

DROP–Drop Port(s)

Use this command with caution. Current calls are immediately
terminated.

Purpose: Terminates line activity on all ports or a specific port. The
caller is instantly disconnected. The port will be ready to answer
another call.

Syntax: DROP n  or  DROP ALL

where n is the port number.

Example: DROP 2
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In this example, all communication on port 2 is immediately
terminated.

ENA–Enable Port(s)

Purpose: Enables one or more ports and permits normal
operations. The ENA command restores normal operations to a port
taken out of service by the DIS command.

Syntax: ENA n  or  ENA ALL

where n is the port number.

Example: ENA 0

In this example, normal operation is restored to port 0.

FORCE–Force System Shutdown

Use this command with caution. Current calls are immediately
terminated.

Purpose: Unlike the SHUTDOWN command, FORCE shuts down
the system without regard to current calls. Activity on all ports is
immediately terminated. This command should only be used as a last
resort to shut down the system.

Syntax: FORCE

You can also shut down the system by selecting Exit from the File
menu.

MEMSTAT–Memory Statistics

Purpose: Displays the AMount of dynamically allocated memory
and the AMount of available extended memory.

Syntax: MEMSTAT
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Example: MEMSTAT

System heap intact. Dynamic Memory Allocated
153K Memory Free 1692K

OPEN–Office Open

Purpose: Instructs the system to immediately activate business
hours.

Syntax: OPEN

The system resets to normal hours at midnight.

RESTART–Reinitialize Voice Board

Purpose: Instructs the system to reinitialize the voice board. All
channels are disabled first. The voice board must be reinitialized to
recognize any changes made that affect the board.

Syntax: RESTART

SHUTDOWN–Shutdown System

Purpose: Shuts down system operations and returns to the
operating system. Unoccupied ports are disabled to prevent further
incoming calls. Each occupied port is automatically disabled after
current calls are terminated. Once all ports are disabled, the system
shuts down and returns to DOS.

Syntax: SHUTDOWN

You can also shut down the system by selecting Exit from the File
menu.
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STATUS–Parameter Status

Purpose: Displays the current status of various system parameters
(in rings, active, event rate, serial count, blanking rate, checkpoint
rate, last message, and message count).

Syntax: STATUS

Example: STATUS

In Rings: 1 Serial Count: 10

Active: 0 Blanking Rate: 30

Event Rate: 40 Checkpoint Rate: 5

Last Message: 1 Message Count: 0

STRESET–Reset System Statistics

Purpose: Resets system performance and application statistics to
zero. Statistics affected are hourly counts, monthly statistics, calls on
each channel, failed calls on each channel, and application statistics.

Diagnostic statistics, serial call counts, and application-defined
statistics are not reset with the STRESET command.

Syntax: STRESET

SYSLOOK–Look at System Command

Purpose: Displays the setting of a specified system file command.

Syntax: SYSLOOK sys_parameter

where sys_parameter is the parameter whose setting you want to
see.

Example: SYSLOOK INBOUND
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This example displays the value of the INBOUND setting (INBOUND
= 1111).

TIME–Set System Time

Purpose: Sets the system time.

Syntax: TIME hhmm

where hhmm denotes the hour and minute in military format.

Example: TIME 1305

In this example, the time is changed to 1:05 PM.

VERSION–Show System Version Number

Purpose: Displays the version number of the system software.

Syntax: VERSION or VER

Example: VER

Version 4.00

<=> Equal Sign–Repeat

Purpose: Causes the most recently entered command to be
repeated. Use the <=> command to avoid repetitive typing when
entering multiple commands.

Syntax: =

Example: STATUS

=

=
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In this example, the STATUS command is followed by two <=>
commands. If the <=> commands are not used, the equivalent would
be:

STATUS

STATUS

STATUS
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Notes:
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Supervisor Keypad Functions

Octel 50 allows you to perform the following system tasks through the
phone interface:

• Manage mailboxes

• Change system prompts

• Manage system distribution lists

• Access the phone interface portion of the Supervisor’s
On-Line Voice Editor (SOLVE)
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Accessing the Supervisor Menu

To use the supervisor keypad functions, you must have access to a
subscriber mailbox with the Supervisor feature enabled in the
assigned class of service.

To access the Supervisor menu:

1. Pick up the telephone receiver, and dial the system’s extension
number. After you hear the initial greeting, press <#> and enter
your supervisor mailbox number.

2. When prompted, enter the mailbox password. If your system
was configured with the extended security feature, press <#>
after entering your mailbox password.

3. From the Subscriber’s menu, press <9> to access the Options
menu.

4. From the Options menu, press <*>, enter the level 2
supervisor’s password, then press <#> to access the Supervisor
menu. The level 2 supervisor’s password is always the same,
whether it is entered through the PC’s keyboard or a telephone’s
keypad. The default level 2 supervisor password is 12345.

The following options are available from the Supervisor menu:

• Mailbox functions

• Change system prompts

• Change system distribution lists

• Use SOLVE

There is only one level 2 supervisor password for the system.
Therefore, if you have more than one supervisor at your location, it is
important that only one supervisor have the authority to change the
password. This minimizes the possibility of other supervisors being
denied access to the Supervisor menu because of incorrect
password attempts.
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Mailbox Functions

To access mailbox functions, press <1> at the Supervisor menu. The
system voices the following mailbox functions options:

• Add a mailbox

• Update an existing mailbox

• Delete an existing mailbox

• Reset an existing mailbox

It is more tedious to create, update, and delete mailboxes through the
phone interface. Therefore, it is recommended that you initially create
mailboxes using the screen interface and use the keypad method to
create an occasional new mailbox when necessary.

Using the phone interface, you can only create or edit mailboxes with
the same entry in the Company field on the Mailbox Entry dialog box
as yours. If your company is blank, you can create, edit, or delete
mailboxes from any company on the system.

Add a Mailbox

From the Mailbox Functions menu, press <1> to add a new mailbox.

To add a mailbox:

1. From the Supervisor menu, press <1> to select Mailbox
Functions. The system voices the Mailbox Functions menu.

2. From the Mailbox Functions menu, press <1> to add a mailbox.

3. When prompted, enter the number of the mailbox you want to
create. The mailbox number must contain the number of digits
specified in System Setup.

To create a guest mailbox through the phone, press <8> at the
Subscriber’s menu of the supervisor’s mailbox.

4. When prompted, enter a password for the mailbox. A
subscriber’s password must be between 1 and 9 digits and
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cannot begin with zero. You can choose to assign no password
by entering <0> at the password prompt.

If the Set Initial Password for New Mailboxes to 1111 parameter
is enabled in System Setup, the system automatically sets the
new mailbox password to 1111 and does not prompt you for a
password.

If the Minimum Length Password parameter defined in System
Setup is greater than four, the subscriber is prompted to enter a
new password with that many digits when the subscriber
accesses the mailbox.

5. When prompted, press <1> if you want to record the personal
prompts for the mailbox or press <2> to proceed. It is
recommended that you allow subscribers to record their own
messages to personalize the system. If you press <2> to
proceed, skip to step 8.

6. If you selected <1> to record the prompt, the system voices the
following options:

• Change the Please Hold prompt–Press <1> to record the
Please Hold prompt. The system voices the Please Hold
prompt when a caller is transferred to an extension. For
example, “Please hold for Mark Johnson.”

• Change the Directory prompt–Press <2> to record the
Directory prompt. The system voices the Directory prompt
when a caller listens to directory listings. For example, “For
Mark Johnson, press one, three, five.”

• Change the Name prompt–Press <3> to record the Name
prompt. The system voices the mailbox owner’s Name
prompt in conjunction with other system phrases. For
example, “Please leave a message for <Mark Johnson>.”

• Change the Personal Greeting prompt–Press <4> to
record the Personal Greeting prompt. The system voices the
Personal Greeting prompt when callers are transferred into
your mailbox. For example, “Hello, this is Mark. I’m either on
another line or away from my desk. Please leave a message,
and I’ll return the call as soon as possible.”
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7. After you select the prompt that you want to record, the system
prompts you to record the prompt at the tone, then press <#>.
Once you record the message, the system voices it and prompts
you to press <1> to accept the prompt, <2> to rerecord the
prompt, or <3> to delete the prompt.

8. Once you record the prompts, the system prompts you to assign
a class of service. Enter the class of service number you want to
assign, followed by <#>. To review a class of service before you
assign it, press <*>, enter the a class of service number, then
press <#>. The system lists the selected options for the specified
class of service.

For information on creating or modifying a class of service, see
Chapter 3, “The Mailbox Menu.”

9. Once you select a class of service, the system voices, “Mailbox
Added.”

10. When you finish creating mailboxes, press <*> to return to the
Mailbox Functions menu.

Update a Mailbox

You can only update mailboxes with the same entry in the Company
field on the Mailbox Entry dialog box as yours.

To update a mailbox:

1. From the Supervisor menu, press <1> to select Mailbox
Functions. The system voices the Mailbox Functions menu.

2. From the Mailbox Functions menu, press <2> to update a
mailbox.

3. When prompted, enter the number of the mailbox you want to
edit. You can only edit mailboxes with the same entry in the
Company field on the Mailbox Entry dialog box as yours.

Guest mailboxes cannot be edited.
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4. Once you select the mailbox you want to edit, the system voices
the mailbox editing options:

• Change mailbox password–Press <1> to change the
mailbox password. A mailbox password can contain from 1
to 9 digits and cannot begin with zero. You can choose to
assign no password to the mailbox by entering <0> at the
password prompt.

• Change mailbox prompts–Press <2> to change the
mailbox prompts. You can record the following prompts:

− Press <1> to change the Please Hold prompt

− Press <2> to change the Directory prompt

− Press <3> to change the Name prompt

− Press <4> to change the Personal Greeting prompt

• Change class of service–Press <3> to change the class of
service. You are prompted to enter the class of service
number you want to assign to the mailbox, followed by <#>.

• Change default operator–Press <4> to change the default
operator. You are be asked to enter the mailbox number of
the default operator. The system replays the number to
confirm it.

5. Select the editing option, and follow the prompts to edit the
mailbox.

6. When you finish editing the mailbox, press <*> to return to the
Mailbox Functions menu.

Delete a Mailbox

When you delete a mailbox, any associated guest mailboxes are also
deleted. You can only delete mailboxes with the same entry in the
Company field on the Mailbox Entry dialog box as yours.

To delete a mailbox:

1. From the Supervisor menu, press <1> to select Mailbox
Functions. The system voices the Mailbox Functions menu.
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2. From the Mailbox Functions menu, press <3> to delete a
mailbox.

3. When prompted, enter the mailbox number of the mailbox you
want to delete.

4. Once you enter a mailbox number, the system voices the number
for confirmation.

5. To delete the mailbox, press <1>. The system voices, “Mailbox
deleted.”

6. When you finish deleting mailboxes, press <*> to return to the
Mailbox Functions menu.

Reset a Mailbox

When a mailbox is reset, all messages stored in the mailbox are
deleted, as well as any recorded personalized prompts, distribution
lists, and folder labels. In addition, all statistics (such as those used in
the reports) for the mailbox are reset to zero. When a mailbox is
reset, the password is not affected.

To reset a mailbox:

1. From the Supervisor menu, press <1> to select Mailbox
Functions. The system voices the Mailbox Functions menu.

2. From the Mailbox Functions menu, press <4> to reset a mailbox.

3. When prompted, enter the number of the mailbox to reset. The
system voices the mailbox number and prompts you to press <1>
to reset the mailbox.

4. Press <1> to reset the mailbox. The system voices, “The mailbox
has been reset.”

5. When you finish resetting mailboxes, press <*> to return to the
Mailbox Functions menu.
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Change System Prompts

The prompts you can record are those specified on the System
Prompts dialog box, and the System Prompt field on the AMIS Node
Entry dialog box. For more information on specifying system prompts,
see Chapter 4, “The Attendant Menu.”

To change system prompts:

1. From the Supervisor menu, press <2> to select Change System
Prompts. The system voices the Mailbox Functions menu.

2. When prompted, enter the number of the prompt you want to
record, from 1 to 999, then press <#>.

3. When prompted, record the prompt at the tone, then press <#>.

4. The system voices the prompts, and prompts you to press <1> to
accept the prompt, <2> to rerecord the prompt, or <3> to delete
the prompt.

5. When you finish recording prompts, press <*> to return to the
Mailbox Functions menu.

The prompt numbers you enter when recording system prompts over
the phone must correspond with the prompt numbers you enter on
the System Prompts dialog box.

Change System Distribution Lists

You can create, edit, or delete system distribution lists. For more
information on system distribution lists, see the topic, “Class of
Service,” in Chapter 7, “The Options Menu.”

To create a system distribution list:

1. From the Supervisor menu, press <3> to select Change System
Distribution Lists. The system voices the System Distribution List
menu.

2. Press <1> to create a system distribution list.
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3. When prompted, press <*>, enter the number of the list you want
to create, then press <#>. A system distribution list number must
be between *10 and *19.

4. When prompted, enter the number of the first mailbox to add to
the list. You can enter a local mailbox number, a personal
network address created for your mailbox, another system
distribution list, or a global list. When you enter a valid mailbox
number, the system voices, “Mailbox added.”  To enter a
distribution list, press <*>, followed by the distribution list number.
When you enter a valid distribution list number, the system
voices, “Distribution list added.”

5. Repeat step 4 for each destination you want to add to the list.

6. When you finish adding mailboxes to the list, press <#>.

7. When you finish creating distribution lists, press <#>to return to
the System Distribution List menu.

To review or update a system distribution list:

1. From the Supervisor menu, press <3> to select Change System
Distribution Lists. The system voices the System Distribution List
menu.

2. Press <2> to review or update a system distribution list.

3. When prompted, press <*>, enter the number of the list you want
to review or edit, then press <#>. A system distribution list
number must be between *10 and *19. The system voices the
distribution list number and the destinations on the list.

4. When prompted, press either <1> to add a mailbox or <2> to
delete a mailbox, then follow the prompts.

5. When you finish adding or deleting mailboxes, press <#>.

6. When you finish reviewing and updating distribution lists, press
<#> to return to the system distribution list menu.

To delete a system distribution list:

1. From the Supervisor menu, press <3> to select Change System
Distribution Lists. The system voices the System Distribution List
menu.
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2. Press <3> to delete a system distribution list.

3. When prompted, press <*>, enter the number of the list you want
to delete, then press <#>. A system distribution list number must
be between *10 and *19. The system voices, “Distribution list
deleted.”

4. When you finish deleting distribution lists, press <#> to return to
the System Distribution List menu.

Supervisor’s On-Line Voice Editor (SOLVE)

SOLVE allows you to use both the Octel 50 screen and phone
interfaces to assign and record system prompts. Prompts recorded
using SOLVE are stored in the \REC00 directory.

Professionally recorded phrases in the SO3-D2.* phrase file may be
reviewed, but not changed or rerecorded. Other prompts, such as
mailbox prompts, cannot modified through SOLVE.

You cannot log into your own mailbox while editing your mailbox on
the screen.

Be sure to write down the prompt numbers assigned to the prompts
you record. You must specify the prompt numbers in the appropriate
fields of the screens on which you specify prompts to be voiced by
the system.

To record and edit prompts using SOLVE:

1. Open the screen on which the prompt number for the prompt you
want to record is to be specified. Place the cursor in the prompt
field. If the field is blank, no custom prompt is currently set up to
voice. You can assign a prompt number in the field now or allow
Octel 50 to automatically assign a number when you record and
accept a prompt.

 If a prompt number exists in the field, a prompt is currently set up
to voice on the system. In this case, you can accept or rerecord
the prompt.

2. To start SOLVE, press <F7>. The Prompt Recorder dialog box
displays and shows the status Waiting for Login.
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3. Call into the system over the phone and log into a supervisor
mailbox.

4. From the Subscriber menu, press <9> to access the Options
menu, then press <*> to access the Supervisor menu, and when
prompted enter the level 2 or level 3 supervisor password.

5. From the Supervisor menu, press <4>. The Prompt Recorder
dialog box shows the status Supervisor logged in.

 

6. To begin recording a new prompt, press the <SPACEBAR>.
When you hear the beep over the handset, begin recording the
prompt.

7. To stop or pause recording, press the <SPACEBAR>. The
prompt recording is saved and assigned to the prompt number
displayed next to Msg #. The length field displays the length, in
seconds, of the prompt.

8. To listen to the prompt, select Play.

9. To delete the prompt and start over, select Delete. The system
prompts you to confirm the deletion. Select Yes to delete the
message.

10. Once you access the Prompt Recorder dialog box, you can
create other new prompts or select existing prompts to review
and edit. To create a new prompt, select New. SOLVE
automatically assigns a new number to the prompt. Use the Next
and Prev buttons to access other prompts.

11. To close the Prompt Recorder dialog box and return to the
prompt screen, select Ok.

12. To log out of the SOLVE phone interface, press <*> on the
phone keypad. Always log out of SOLVE by pressing <*> before
hanging up the handset to allow the port to reset.
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Notes:
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V-Trees

This section provides information on creating V-Trees for system
mailboxes.

The V-Tree feature and certain options associated with V-Trees may
not be available to your mailbox, depending on:

• Your phone system

• The type of Octel 50 system installed and the way the system
is configured

• The features assigned to each mailbox
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About V-Trees

V-Trees are menus that you can create to provide callers with options
they can choose from to perform actions on the system. Callers use
a V-Tree the same way they use the Attendant menu on the system,
yet V-Trees are assigned to specific mailboxes, not to the entire
system. You can, for example, set up the system so if a caller selects
an option from the Attendant menu to speak to the sales department,
the call is transferred to a mailbox where a V-Tree prompts the caller
to choose to speak with either the product A, product B, or product C
sales group. Depending on the caller’s selection, the call is then
routed to the appropriate extension.

Each menu on a V-Tree can provide callers with up to nine options.
Each option performs a certain action on the system, including
advancing the caller to another menu that contains additional options.
You can create as many menus as necessary.

A typical V-Tree may start by greeting callers and prompting them to
press <1> for accounting, <2> for sales, or <3> for technical support.
If callers press <1> for accounting, they advance to a second level
and may be prompted to press <1> for billing procedures, <2> for
credit application, or <3> to speak with an account representative.

By constructing a V-Tree in a mailbox, you can reduce the number of
calls from callers who:

• Need to speak with another person in your company

• Want to be added to your mailing list

• Want to place an order

• Request general information

• Request to have documents faxed to them
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V-Tree Action Codes

There are 13 actions that can be assigned to the options on a V-Tree
level. You can also create a level that has no options, only a defined
prompt. In this case, be sure to select None for each option on that
level.

If you create a V-Tree through the phone interface, note that the last
four action codes are called Advanced Options 1-4. However, they
perform the same functions as the action codes listed for Visual
V-Trees.

Advance to next level
This action code advances a caller to the menu for the next level.
When you select this action code, a Next button appears to the right
of the option. This button allows you to move to the next level. Use
this action code to create another level from which the caller can
select different options. Make sure your prompt at this level instructs
the caller which keypad buttons to press for which options.

Transfer to a mailbox
This action code transfers a caller to another mailbox or its
associated extension on the system. When you use this action code,
enter the number of the mailbox to which the caller should be
transferred. Use this action code if, for example, you want to give the
caller the option to be transferred to a sales representative. Note that
you can transfer the caller to another mailbox that is also blocked by
a V-Tree.

Record to mailbox and return
This action code allows a caller to record a voice message. When
you use this action code, enter the number of the mailbox to which
the message should be recorded. After recording a message, the
caller is returned to the previous V-Tree menu. Use this action code
to collect information from the caller.
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Disconnect
This action code disconnects a caller from the system. When callers
disconnect from the system using this action, the line they were using
frees more quickly.

Return to previous level
This action code returns a caller to the last level where there was
more than one option. This action code enables the caller to choose
one option from a menu and return to the previous menu to choose
another option.

Go to directory services
This action code transfers a caller into the subscriber’s directory
where the caller can find a particular subscriber’s extension and dial
it to transfer to the extension.

Record to mailbox and advance
This action code allows a caller to record a message and
automatically proceed to the next level. When selected, this action
code requests the number of the mailbox to which the message
should be recorded. You can use this action code in a series, to
collect data such as product order information from callers. The
information the caller leaves at each level’s prompt is merged into a
single message and stored in the new message queue of the mailbox
you specify.

Go to mailbox entry point
This action code returns a caller to the automated attendant or voice
mail entry point (“Please enter the extension number...”), where the
caller can choose to transfer to a subscriber’s extension.

Go to voice mail
This action code prompts a caller for the destination mailbox number,
then transfers the caller to voice mail. (“Enter the destination mailbox
number. Please leave a message for... .”)
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Send a requested fax and advance (Advanced
Option 1)
This action code allows callers to receive fax documents, such as
product information sheets, technical bulletins, or product order forms
that you store on the system. When you select this action code, a
Next button appears to the right of the option. Select this button to
define the next required level of the V-Tree. With this option, callers
receive faxed information simply by entering the number (up to eight
digits) of the document they want to receive. You can provide a short
directory of available documents and their corresponding document
numbers in the prompt for the level.

Send a predefined fax and advance (Advanced
Option 2)
This action code also allows you to fax information to callers. When
you select this action code, a Next button appears to the right of the
option. Select this button to define the next required level of the
V-Tree. This action code enables you to set up the delivery feature so
callers use a single keypress.

When you include either of the fax retrieval options in your V-Tree,
the system prompts callers requesting faxed information to enter the
fax machine telephone number to which the document should be
sent. The fax machine telephone number can be a local, long
distance, or international number.

Review/edit message (Advanced Option 3)
This action code allows a caller who has recorded information into a
mailbox using the record to mailbox and advance action code to
review, and, if necessary, rerecord the information. Note that when a
caller records to a certain mailbox over a series of V-Tree levels or
branches, the recorded information is merged and then stored as one
message in the mailbox. When the caller selects this option from a
V-Tree branch, the system plays the entire merged message as it is
in the mailbox. If the caller elects to rerecord the information, the
system places the call at the starting point of the recording process
for that branch and again prompts the caller for the information.

It is important that you do not set up a V-Tree so that callers record
information to the same mailbox from different V-Tree branches. If
you do, callers selecting this option will hear the entire merged
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message but only be prompted to rerecord the information asked for
on that particular branch. Information the caller recorded to the same
mailbox from other V-Tree branches is lost.

If the mailbox to which messages are being recorded is auto-
forwarded to another mailbox, be sure the auto forward delay allows
enough time for the caller to review or edit the message before it is
forwarded.

Go to mailbox login point (Advanced Option 4)
This action code allows the caller to transfer to the mailbox login
point on the system. When transferred, the caller hears, “Please
enter your mailbox number.”

The Visual V-Tree Onscreen Interface

Creating V-Trees visually provides a number of advantages,
including the ability to record the V-Tree prompts using SOLVE and
the ability to view the series of keypresses necessary to access
different levels of the V-Tree.

To create or edit a Visual V-Tree:

1. Access the Mailbox Entry dialog box by either creating or editing
the mailbox for which you want to create the V-Tree.

2. Select the Visual V-Tree option. The Visual V-Trees dialog box
displays.
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 The nine numbered buttons represent the options you can
provide to callers on the current level

3. To select an action for the first option, highlight the option’s
associated button, then press <ENTER>. A list of available
actions displays.

4. Highlight the action you want to assign, then press <ENTER>.
The action name displays next to the option number.

 If the action you select requires you to define a variable such as
a mailbox number or fax document number, a field displays next
to the option field. You must define the variable for the V-Tree to
function properly.

 If the assigned action requires you to define a subsequent level,
a Next button displays next to the option field.

5. Repeat steps 3 and 4 for each option you want to define on the
first level.

6. If you want callers at the current level to be able to either enter an
extension number or select a menu option, select Attendant
Menu Options.

7. If you enabled Attendant Menu Options, use the Mailbox Input
Timeout field to enter the number of seconds callers have to
enter an extension number instead of an option number. For
most systems, 3 should be sufficient.

Callers can use the <#> or <0> keys at any level regardless of
whether Attendant Menu Options is selected. When callers press
the <#> key on the first level of the V-Tree, the system transfers
them to a mailbox login point. When callers press the <#> key at
any other level, they return to the previous level. When callers
press the <0> key, they are transferred to the default operator or
the personal operator, if one is defined. These options are not
automatically voiced to callers and must be specified in the
V-Tree prompt if you want callers to be aware of them.

8. In the Prompt field, enter the number of the prompt you want the
system to voice for that level. You can record the prompt through
the phone interface or using SOLVE. To specify a prompt stored
in the language files, precede the number with the letter D. Note
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that this prompt should include the actions available at the
current level.

9. For each option with a Next button displayed, select the Next
button and repeat steps 3-8.

10. To display the sequence of keypresses required for a caller to
advance to the current level of the V-Tree, select Path.

11. To return to the previous level of the V-Tree, select Previous. To
return to the first level of the V-Tree, select Top.

12. To exit the V-Tree, select Exit. The Mailbox Entry dialog box
displays.

After you create the V-Tree, call into the system, log into the mailbox,
access the Special Features menu and select <8> to create or edit a
V-Tree. From the V-Tree menu, select <2> to review the V-Tree and
verify that the V-Tree is activated correctly and each prompt and
option works appropriately. If the V-Tree is not functioning correctly,
open the V-Tree, make the necessary changes, then resave the
V-Tree.

After you verify the V-Tree, you must select the call conditions under
which you want callers to hear the V-Tree. For more information, see
the topic, “Activate the V-Tree,” later in this chapter.

The V-Tree Phone Interface

Octel 50 allows you to create a V-Tree over the phone from the
Special Features menu. Note that to create a V-Tree over the phone,
you must be logged into the mailbox in which you want to create the
V-Tree.

When you create a V-Tree over the phone, it is recommended that
you create the first option on a level, then create all of its subsequent
options. This is called a branch. When you reach the end of the
branch, return to the first level of the V-Tree and create the second
branch of the V-Tree.

Before creating a V-Tree using the phone interface, review the
information provided in this section on the available actions you can
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assign to options on each V-Tree level. Then diagram on paper the
structure of the V-Tree you intend to develop. These notes will greatly
assist you as you develop each branch of the V-Tree.

To create a V-Tree through the phone interface:

1. Log into your mailbox and press <9> from the Subscriber’s Main
menu.

2. From the Options menu, press <2>.

3. From the Special Features menu, press <8>.

4. From the V-Tree menu, press <1> to create or update the
V-Tree. The system voices, “Level number one,” and lists 8
editing options from which you can select.

5. Press <6> to define the prompt for the first level. This is the main
greeting of the V-Tree. The system prompts you to press star to
record the prompt or enter the number of the prompt to use.

6. If you already recorded the V-Tree prompts, enter the number of
the prompt to use at the main greeting, then skip to step 10.

7. If you have not recorded the prompt, press <*> to record it now.

8. At the tone, record the prompt, then press <#>. The system
voices the prompt for verification.

9. Press <1> to accept the prompt or <2> to rerecord it. Once you
accept the prompt, the system voices the editing options.

10. Press <2> to create an option. The system prompts you for the
number of the option to add.

11. Enter the number of the option you want to add. The system
prompts you to enter the action you want to assign to this option
and voices the list of available options.

12. Enter the action to assign to the action. The system voices the
editing options.

13. If you want to create a subsequent option on the current branch,
press <5> to execute an option. The system prompts you to enter
the number of the option to execute. If you do not want to create
another option on the current branch, skip to step 16.
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You can review the options on the current level and their
assigned action codes by pressing <1> from the editing options.
If you need to delete an option on the current level, press <3>
from the editing options, then when prompted enter the number
of the option you want to delete. Note that when you delete an
option, any subsequent options on that branch of the V-Tree are
also deleted.

14. Press <1> to execute option 1. The system automatically creates
level 2 (“Creating level. Level number 2.”)  The system then
voices the editing options.

15. Repeat steps 5 through 9 to record the prompt for the second
level.

16. Repeat steps 10 through 12 to create the first option on the
second level.

17. To create subsequent levels of the current branch, repeat steps
13 through 16 for each level.

18. When you finish creating options for the current branch, press
<9> to return to the top of the V-Tree. The system voices the
editing options.

19. Repeat steps 10 through 18 to create the each additional V-Tree
branch and return to the top of the V-Tree. The system voices
the editing options.

You can insert a new level of options after the current V-Tree
level at any time without recreating the entire V-Tree. To insert a
level, press <7> from the editing options. When prompted, enter
the number of the option after which the new level should be
inserted. The system then creates the new level, for which you
can then record a prompt and assign options.

20. When you finish creating the V-Tree, press <#> to return to the
V-Tree menu.

21. Press <#> to return to the Special Features menu.

22. Press <#> to return to the Options menu.

23. Press <#> to return to the Subscriber Main menu.
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24. Press <#> to exit the system.

After you create the V-Tree, call into the system, log into the mailbox,
access the Special Features menu and select <8> to create or edit a
V-Tree. From the V-Tree menu, select <2> to review the V-Tree and
verify that the V-Tree is activated correctly and each prompt and
option work appropriately. If the V-Tree is not functioning correctly,
open the V-Tree, make the necessary changes, then resave the
V-Tree file.

After you verify the V-Tree, you must select the call conditions under
which you want callers to hear the V-Tree. For more information, see
the topic, “Activate the V-Tree,” later in this chapter.

To delete a V-Tree through the phone interface:

1. Log into your mailbox and press <9> from the Subscriber’s Main
menu.

2. From the Options menu, press <2>.

3. From the Special Features menu, press <8>.

4. From the V-Tree menu, press <3> to delete the V-Tree.

5. Press <#> to return to the Special Features menu.

6. Press <#> to return to the Options menu.

7. Press <#> to return to the Subscriber Main menu.

8. Press <#> to exit the system.
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Activate the V-Tree

After you create the V-Tree, you must activate it for the mailbox by
selecting it from the Call Handling features.

To activate the V-Tree:

1. Access the Mailbox Entry dialog box for the mailbox in which you
created the V-Tree.

2. Select Subscriber Settings. The Subscriber Settings dialog box
displays.

3. If you want calls to be immediately addressed by the V-Tree
without having the system first ring the mailbox extension, select
the Call Blocking option, then select the V-Tree option under No
Answer/Call Blocking.

4. If you want calls addressed by the V-Tree after there is no
answer at the mailbox extension, do not select the Call Blocking
option, then select the V-Tree option under No Answer/Call
Blocking.

5. If you want calls addressed by the V-Tree when the mailbox
extension is busy, select the V-Tree option under Busy.

6. Select OK to accept the settings. The Mailbox Entry dialog box
displays.

7. Select OK to close the Mailbox Entry dialog box. The Octel 50
main screen displays.

To deactivate a V-Tree, access the Subscriber Settings dialog box,
and change the call handling options for the mailbox.
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How to Troubleshoot the System

This section provides a list of steps that should be followed when
troubleshooting the Octel 50 system.
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Troubleshooting Steps

Follow these basic steps to effectively troubleshoot a problem:

1. Collect data and investigate. Collect sufficient data to fully define
what is working and what is not.

2. Evaluate the collected data.

3. Isolate the trouble source.

4. Determine cause for failure. Check potential trouble sources
relevant to that particular problem.

5. Take action to correct or repair the problem.

6. Retest to ensure the problem has been corrected.

The following categories contain the types of problems encountered,
along with their solutions. Note that while running the system or some
system modules, you can press <F1> to access context-sensitive
help, and you can press <SHIFT+F1> to access an alphabetical Help
menu.

System Issues

Callers are being disconnected from the system:

• Increase the Maximum Number of Errors parameter in System
Setup.

• Increase the Maximum Number of No Entries parameter in
System Setup.

• If the Disconnect All Rotary Callers parameter in System Setup is
active, instruct all calls from rotary phones to call another
number.

• The system may interpret the caller’s voice as a dial tone. Try
setting the DTONDET parameter in System Setup higher.
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Calls to certain ports do not answer:

• Be sure that the INBOUND parameter in System Setup is set to
“1” for that port.

• If the port was disabled using the DIS command, enable it by
typing ENA n and pressing <ENTER> at the command line
interface, where n equals the number of the port.

The Channel Status Display does not display more than the first
four installed ports:

• Use the Next Channel Status to display more than four ports.
Each time you select Next Channel Status, the next four ports
are displayed (up to the maximum of 12 ports).

The system is not detecting DTMFs:

• Check the PLAYDTMF value in System Setup. If it is too high,
the system may not recognize a DTMF. If it is too low, the system
may interpret a voice as a DTMF.

• Check the RECDTMF value in System Setup. This parameter
controls the length of the DTMF needed to interrupt a recording.

• Check the TONEDLY parameter value in System Setup. This
parameter controls the amount of time necessary between valid
DTMFs.

• Check the TONELEN parameter value in System Setup. This
parameter controls the necessary length of the DTMF.

Receiving Error Message “Error starting fax communication”:

• Octel 50 may have had problems restarting the fax board.

• The file that contains the cover page may be corrupt. Try creating
a new test cover page.

Receiving Error Message “Fax Retrieval not supported” or “Fax
Mail not supported”:

• Usually the wrong sentinel unit has been installed. Contact your
authorized representative.
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Receiving Error Message “SMDI driver not supported”:

• Usually the wrong sentinel unit has been installed. Contact your
authorized representative.

Cannot exit the Octel 50 system:

• Select Exit from the File menu. Choose Shutdown.

• If Exit with Shutdown does not work, select Command Line from
the Display menu. Type SHUTDOWN at the command line
interface and press <ENTER>. This disables any unoccupied
ports and terminates the program after all current calls are
completed.

• If all else fails, type FORCE at the command line interface or
select Exit with Force from the File menu.

Use this only as a last resort since it terminates calls without
warning.

Cannot use the mouse:

• Confirm that the mouse driver is executed during system bootup.

Ports are coming off hook even though there may not be a line
plugged into that port (ghost calls):

• Be sure that all ports specified for outdialing (the OUTBOUND
parameter is set to 2 in System Setup) have a dial tone. If not,
the system assumes a call collision.

The propeller stops spinning:

• Attempt to exit the system by selecting Exit from the File menu.

• If you cannot exit, select Command Line from the Display menu.
Type SHUTDOWN then press <ENTER> from the command line
interface.

• If Shutdown has no effect, type FORCE then press <ENTER>.
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• If neither Shutdown nor Force works, contact a technical support
representative.

The receptionist receives many blank messages that are not the
result of the caller hanging up:

• Be sure that all ports specified for outdialing (the OUTBOUND
parameter is set to 2 in System Setup) have a dial tone. If not,
the system assumes that a call is incoming when it is trying to
place an outbound call.

• Try increasing the Minimum Message Length parameter.

Reports do not print:

• Confirm that the reports are instructed to be sent to the printer on
the Report Specification dialog box.

• Verify the PRINTER parameter in System Setup is set to the
correct LPT port.

• Make sure the printer is ready to print: the printer has power, is
online, and contains paper.

• The printer may be hung. Use the CLRPRT command from the
command line interface to clear the printer.

Cannot send reports to disk:

• Confirm that reports are instructed to be sent to a disk file on the
Report Specification dialog box.

• Be sure that a disk path and filename are specified on the Report
Filename dialog box.

• Be sure that a formatted diskette is in a valid system diskette
drive and that the drive door is closed.
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System Feature Issues

Attendant menu prompt does not work:

• Make sure that Greeting by Port is not active for that port.

• Confirm that an Attendant menu is configured. A keypad button
on the dialog box should have a valid corresponding mailbox
number next to it.

• Confirm that message prompt numbers are specified on the
System Prompts dialog box in the Attendant menu Language 1
field and that the prompt is recorded.

• Verify that phones are sending valid DTMF signals.

• Adjust the RECDTMF and PLAYDTMF values in System Setup.

System greeting prompts (Morning, Afternoon, Evening, Closed)
do not work:

• Make sure that the Morning, Afternoon, and Evening start times
are specified under Time/Date in System Setup.

• Be sure that Selected Hours is chosen and that the business
hours are entered correctly on the Business Hours dialog box
accessed from the Attendant menu.

• If using supervisor prompts, confirm that the prompt numbers are
specified on the System Prompts dialog box and that the prompts
have been recorded.

• Note that the greeting prompts are only used during business
hours. For example, if the Morning Start Time is specified as
7:00 AM, but business hours do not begin until 8:00 AM, the Office
Closed Greeting is voiced to callers between 7:00 AM and 7:59
AM.
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Greeting by Port does not work:

• Be sure that the ports you want to use for greeting by port are
configured and activated on the Greeting by Port dialog box.

• Confirm that the personal greetings for both the During and After
Hours mailboxes are recorded. The personal greeting is used to
answer calls to those ports for greetings by port.

• Make sure that the proper business hours are indicated for each
port.

Holiday greeting prompt does not work:

• Be sure that the date is specified as a holiday on the Holiday
entry dialog box.

• Confirm that the date set on the PC is correct.

• If using supervisor’s prompts, check to see if a message number
is entered on the Holiday dialog box for use with this particular
date.

• Confirm that message prompt numbers are specified on the
System Prompts dialog box, and that the prompts are recorded.

• If a holiday greeting voices on a non-holiday date, access the
Holiday entry dialog box, and check to see if the Retain field is
selected for the date in question. If so, this date was specified as
a holiday in a previous year but is not this year.

Multilingual Octel 50 does not work:

• Make sure the Number of Languages parameter in System
Setup is set to the correct number.

• Be sure that the phrase files for each language are recorded,
digitized, and saved as the correct filename.

• If using supervisor prompts, be sure that a Language Select
prompt is specified on the System Prompts dialog box, and that
the prompt has been recorded.

• Be sure that the Attendant Menu and Message Delivery prompts
in each language being used are recorded. Specify the
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appropriate prompt numbers on the System Prompts dialog box,
and then access the Supervisor menu through the phone. Press
<2> to change system prompts, and record the corresponding
prompt numbers.

Selecting Item Issues

Fields and buttons do not work:

• If a button does not work, press <ALT> plus the first highlighted
character of the button name.

• Use the <TAB> or <SHIFT+TAB> key to move the cursor to the
field or button, and press <ENTER>.

• Use the mouse to point and click the field or button.

• Make sure the mouse in properly installed.

Cannot select items within parentheses ( ) or brackets [ ]:

• Move to the field with the <TAB> or <SHIFT+TAB> key or with
one of the other options described above for selecting a field or
button. Press <SPACEBAR> to activate the toggle (On/Off) for
that field.

• Note that you can only select one item of a set with parentheses
( ). However, in a set with brackets [ ], you can select any number
of the options.

Menus do not work:

• The menus cannot be selected if the Mailbox Status display is
active.

• Use the <TAB> or <SHIFT+TAB> key to move the highlighted
bar among the menus. Press <ENTER> once the option you
want to select is highlighted.

• Use the left and right arrow keys to move the highlighted bar
among the menus. Press <ENTER> once the option you want to
select is highlighted.
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• Type the first highlighted character of the menu name (or hold
down the <ALT> key and the first highlighted character of the
menu name). Use the <ALT> key sequence if the command line
interface is active.

• Use the mouse to point and click the menu you want to select.

Supervisor Action Issues

Cannot access certain menus and functions on Octel 50’s main
window:

• You must be logged in as a level 2 or 3 supervisor to access
most features on-screen.

• Make sure that the correct level of security access is entered. To
access the functions under all menus but the Options menu (with
the exception of the AMIS Maintenance option), enter the level 2
security password (Default = 12345). To access all system
functions, including those on the Options menu, enter the level 3
security password (Default = 67890).

• If another supervisor changed the password and the new
password was forgotten, contact your authorized representative
for further instructions.

Cannot change class of service during mailbox creation or
editing:

• Note that a defined class of service can only be created or
changed under the Options menu by a level 3 supervisor.

• A level 3 supervisor can change a class of service for an
individual mailbox by selecting the class of service that most
closely matches the features you want to select, choosing Create
Custom COS on the Class of Service dialog box, and modify and
save the class of service.

• Note that only supervisors with the same company as the
subscriber mailbox can edit that mailbox over the phone.
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Cannot Edit a mailbox:

• Make sure the correct level 2 or 3 supervisor password was
entered.

• A guest mailbox cannot be edited.

• You cannot edit a mailbox that is occupied.

• Only supervisors with the same Company designation as the
mailbox owner can edit that mailbox over the phone.

Subscriber Action Issues

Cannot access certain features:

• Be sure that the features are activated (if necessary) in System
Setup.

• Confirm that the features are allowed for the mailbox in the class
of service.

• Have the mailbox owner attempt to activate the features over the
phone.

• Note that a guest mailbox only has access to the send and
receive features.

Cannot edit a sent message:

• Verify that Sent Message Editing is permitted for the mailbox in
the class of service.

• A sent message cannot be edited if it has already been received
(listened to) by its recipient.

• Messages scheduled for dispatch to a remote system cannot be
edited.
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Cannot log into a mailbox:

• Dial the system’s extension or phone number, and press <#>
after the main system greeting. Enter the mailbox number
followed by the password. The default subscriber password is
1111.

• Subscribers must press <#> after the password if the extended
security feature is active to immediately access their mailboxes.
If they do not press <#>, there is a delay before the Subscriber
menu is voiced.

• If the subscriber is told that the password entered is invalid, try to
log in again (in the event that the password was entered
incorrectly).

• A subscriber must enter a new password if the minimum length
password parameter is defined as a number greater than the
number of digits in the current password or the subscriber cannot
proceed.

• A guest mailbox is deleted with its sponsor mailbox. Confirm the
status of the sponsor mailbox.

• You can assign a new password through either the Edit Mailbox
dialog box or the phone if the subscriber cannot remember the
password.

Cannot save messages:

• Confirm that Save Message is enabled in the mailbox’s class of
service.

• Make sure that the Number of Days to Save Saved Messages is
not set to zero.

• Note that Listen-Only messages cannot be saved.

Cannot send and/or receive messages:

• Confirm that Send Message or Receive Message is enabled in
the mailbox’s class of service.

• If the mailbox is a guest mailbox, it can send messages only to
its sponsor mailbox.
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• If the Total Time or the Maximum Messages permitted in the
class of service is reached, the subscriber may experience send
or receive problems. Delete messages or increase these
message limitations.

• Confirm that the mailbox is permitted AIM functions, including
Reply. Note that users who have AIM functions must also have
Send Message and Receive Message enabled in the class of
service.

Cannot record prompts:

• Confirm that the Record Prompts feature is permitted for the
mailbox in the class of service.

Mailbox Issues

Cannot delete statistical information:

• Select the Clear option from the Mailbox menu to clear statistics
for a specific mailbox or a range of mailboxes.

• You can reset the mailbox using the supervisor keypad functions
over the phone by pressing <1> from the Supervisor menu for
mailbox functions and <4> from the Mailbox Functions menu to
reset a mailbox.

A mailbox does not appear in company directories or reports:

• The Company field may have been entered inconsistently or left
blank on the Mailbox Entry dialog box. Check the fields for errors
or omissions.

Callers are told that the mailbox is full:

• The Max Messages or the Total Time value in the class of
service has been reached. Messages must deleted to allow for
more recording time in the mailbox, or the Max Messages or
Total Time values can be increased.
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Cannot include a certain mailbox in any reports or the Search
Window:

• If a mailbox fails to appear in any reports or the Search window,
a Name was not entered on the Mailbox Entry dialog box. Edit
the mailbox, and type an entry in the Name field.

Mailbox Feature Issues

Call forwarding does not work:

• Determine how many extensions are being forwarded, and make
sure the Maximum Number of Forwarded Extensions in System
Setup is not being exceeded.

• Confirm that Call Handling is permitted in the class of service.

• Verify that Call Forwarding is selected as the call handling option
on the Subscriber Settings dialog box.

• Make sure that the extension is being forwarded to a valid
extension number.

• Be sure the correct call condition is being satisfied for the call
forwarding to work properly:  Busy, No Answer, Busy or No
Answer, or Call Blocking.

Call handling does not work:

• Confirm that the mailbox is permitted call handling in the class of
service.

• Verify that call handling is enabled for the correct condition and
option on the Subscriber Settings dialog box.

• Be sure that the subscriber fulfills the Call Handling
requirements:  records Optional prompts, enters a forwarding
extension, or creates a V-Tree.
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Call queuing does not work:

• Make sure Call Queuing is permitted for the mailbox in the class
of service.

• Check that Call Queuing is activated for the mailbox.

• If using supervisor’s prompts, confirm that the 10 Call Queuing
phrases are specified on the System Prompts dialog box, and
that the prompts have been recorded.

• Confirm that the Number of Seconds for the First Caller in the
Queue to Wait is set correctly in System Setup.

• Be sure that the Maximum Number of Callers Allowed in Queue
parameter in System Setup is not set to 0.

Call screening does not work:

• Confirm that the appropriate Call Screening Busy, No Answer,
and Reject release codes are entered correctly in System Setup
for the switch.

• Be sure that Call Screening is permitted for the mailbox in its
assigned class of service.

• Verify that Call Screening is enabled on the Subscriber Settings
dialog box.

• If the system returns a rejected call to the attendant, try holding
the call longer after it is rejected. (This applies to proprietary
phone sets such as the Mitel Superset.)

Distribution lists do not work:

• Be sure that Distribution Lists are permitted for the mailbox in the
class of service.

• Confirm that a distribution list is created.

• When sending a message to a distribution list, be sure to enter
<*> followed by the distribution list number. Personal distribution
lists are numbered *0-*9. System distribution lists are numbered
*10-*19. List *98 contains the mailbox numbers of all subscribers
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in your department. List *99 contains the mailbox numbers of all
subscribers in your company.

• If messages to long distribution lists make the system seem
sluggish, you can edit the SET_UP.CFG file and change the
value of G42 to represent the number of mailboxes between
updates to the sender.

Fax retrieval does not work:

• Confirm that the following parameters are set correctly on
System Setup:  Fax Board Type, Use a Fax Cover Sheet,
Number of Attempts When Sending a Fax, and Fax Prefix Code.

• Make sure that a line for outbound calls is specified with the
OUTBOUND parameter in System Setup.

• Be sure that both the fax and V-Tree options are permitted for
the mailbox in the class of service.

• The subscriber must have created and activated a V-Tree that
includes the fax option.

• Be sure that the fax port and interrupts are set correctly.

• Fax retrieval is a sentinel-controlled feature; make sure you are
using a sentinel that supports the Fax Solution module.

Global Distribution Lists do not work:

• Be sure that Global Distribution is enabled in the mailbox’s class
of service.

• Confirm that there are existing system distribution lists.

• When sending a message to a distribution list, be sure to enter
<*> followed by the distribution list number. Personal distribution
lists are numbered *0 - *9. System distribution lists are numbered
*10-*19. List *98 contains the mailbox numbers of all subscribers
in your department. List *99 contains the mailbox numbers of all
subscribers in your company. For *98 and *99 to properly work,
department and company names must be used consistently.
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Intercom paging does not work:

• A paging system must be installed for Intercom Paging to be
available.

• Confirm that an Intercom Paging Code is specified in System
Setup.

• Make sure that Intercom Paging is enabled in the mailbox’s class
of service.

• Be sure that the number of the paging system is entered in the
Number field on the Subscriber Settings dialog box, if using zone
paging.

• Check the Subscriber Settings dialog box to verify that Intercom
Paging is set to On or Automatic.

Message confirmation does not work:

• Be sure that Confirmation is permitted for the mailbox in the
class of service.

• Note that only messages tagged for message confirmation when
sent can actually be confirmed.

• Note that message confirmation is checked from the Subscriber
menu.

• Messages sent to remote sites in AIM cannot be sent with
confirmation.

Message delivery does not work:

• Be sure that the mailbox is assigned a class of service that
permits Message Delivery.

• Make sure that a line for outbound calls is specified with the
OUTBOUND parameter in System Setup.

• In System Setup, be sure that the Code for Accessing an Outside
Line (for example, 9,) is specified. If Message Delivery is to an
internal extension (less than the Number of Digits in Local
Telephone Number), the switch may require a Custom Message
Delivery Code.
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• Confirm that message delivery is not disabled on the Subscriber
Settings dialog box.

• Make sure that the Message Delivery entries are active on the
Message Delivery dialog box.

• Check to see that appropriate On and Off Times and On and Off
Days are specified on the Message Delivery dialog box.

• Be sure that the paging number is valid, and that any special
characters required have been entered.

• Be sure that the mailbox is permitted either local and/or long
distance delivery under Message Delivery on the Class of
Service dialog box.

• Make sure the Call Back number entered on the Message
Delivery dialog box is correct.

• Confirm that the line number entered in the Line 1 field is set to 2
in the OUTBOUND parameter in System Setup.

Message waiting lights (MWLs) do not work:

• Confirm that the Permit Message Waiting Lights parameter is
enabled in System Setup.

• If required, be sure that Prefix and Suffix ON and OFF codes are
specified in System Setup.

• Confirm that the Message Waiting Light Supervised parameter in
System Setup is set correctly in System Setup.

• Confirm that the Light Message Waiting Lights parameter is set
correctly in System Setup.

• Be sure that Message Lights are enabled in the mailbox’s class
of service.

• If SMDI is used, check the cable and the SMDI configuration file.

• Message waiting lights require the use of an outbound line. Make
sure that a port in the OUTBOUND parameter in System Setup is
set to 2.
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• Note that message waiting lights do not work on every system.
Both the subscriber’s phone and switch must support the use of
message waiting lights. Make sure that the phone switch is
properly configured to work with the phone.

• Be sure that the Code for Accessing an Outside Line is correct. If
so, be sure the PAINTVL parameter has the correct value for
length of pause.

Voice folders do not work:

• Confirm that Voice Folders are permitted for the mailbox in the
class of service.

• Be sure that the folders are defined and have recorded label
names.

• Confirm that messages are being saved to the proper folders.

V-Trees do not work:

• Be sure that the mailbox is permitted V-Trees in its assigned
class of service.

• Confirm that a V-Tree exists in the appropriate mailbox.

• Verify that V-Tree is selected as the mailbox’s call handling
option on the Subscriber Settings dialog box.

• Call into the mailbox, access the Special Features menu, and
review the V-Tree to determine if all options have been assigned
an action code.

Wake-Up Calls do not work:

• Be sure that Message Delivery is permitted for this mailbox in the
class of service.

• The system attempts the wake-up call number at 1-minute
intervals until either the phone is busy 20 times, there is no
answer 20 times, or someone answers the call. The default
number of attempts can be changed by editing value G55 in the
SET_UP.CFG file.
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Message Issues

Messages are disappearing from subscribers’ mailboxes:

• If Auto Forwarding is active on the Auto Forwarding dialog box,
confirm that the Delete message after forwarding option is
disabled.

• When the Number of Days to Save Messages expires,
messages are automatically deleted. To “warn” subscribers of
deleted messages, activate the Voice Warning When Messages
Expire parameter in System Setup.

• The Number of Days to Save Messages can be set to 99,
allowing saved messages to remain on the system indefinitely.

• A message is removed from the saved message queue when its
age is equal to the Days to Save Saved Messages, where age is
equal to the number of days in the new message queue plus the
number of days in the saved message queue. Therefore, if the
Days to Save Saved Messages is set to 10, and a message is
received on the third day after it was sent, its potential saved life
would equal 7 days. If the message is listened to again from the
saved message queue on day 4 of its existence, it can only be
saved for 6 additional days.

Recovering accidentally deleted messages:

• If the message was deleted during the current session, the
subscriber can press <5> from the Subscriber menu to hear all
messages deleted during the session, then press <1> to recover
a deleted message.

• You can activate the Enable Extended Password Security option
in System Setup to require subscribers to confirm message
deletions.
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Notes:
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A P P E N D I X  A

Templates

This section contains templates the system supervisor should
complete prior to installation to assist in the configuration and
implementation of Octel 50.  After implementation, the supervisor
can also use the first three templates (Mailbox Assignment and
Setup Summary, Class of Service Definition, and Message
Delivery Setup) to notify subscribers of available mailbox
features.  Collectively, all the templates serve as a convenient
record keeping tool for the system supervisor.

The Octel representative installing the Octel 50 system should
complete and retain the Customer Database Information sheet.
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Mailbox Assignment and Setup Summary

Mailbox Number ________ Extension Number ________
First Name ________ Last Name ________
Company ________ Division ________
Password Personal Operator ________
Class of Service

Auto Forward
Auto Forward to Extension ________

Delay: hours_____ minutes_____

Subscriber Settings

Call Blocking Paging Number    ________

Message Delivery No Answer/Call Blocking
Urgent Default V-Tree
All Opt. Prompt 1 Forward
Disabled Opt. Prompt 2 Forward # _______

   Special Options Busy
Call Queuing  Default V-Tree
Call Screening  Opt. Prompt 1 Forward
Intercom Paging  Opt. Prompt 2 Forward # _______

When using intercom redirect, if you are being paged for a call, dial
into the system and press <#> <*>.  The system asks you to enter
your mailbox number.  To retrieve the call to an alternate extension,
enter either the extension number followed by <#>  or <#> followed
by the mailbox number.

Guest Mailbox Number(s)

____________ ____________ ____________
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Class of Service Definition #_______

For information on class of service options, see the topic, “Class
of Service,” in Chapter 7, “The Options Menu.”

Features
Call Global Dist. List Save Msgs.
Msg. Conf. Dir. Access Undelete Msgs.
Voice Folders Call Handling Msg. Scan
Call Queuing V-Tree Sent Msg Editing
Msg. Light Fax V-Tree Record Prompts
Intcm. Paging Send Msgs. Operator Access
Dist. Lists Receive Msgs. Supervisor

Message Delivery
Not Allowed Long Distance
Local Only Batch

Fax Mail
Send Messages
Receive Messages

Message Information
Max. Msgs.  _______ Save New Msgs.     _______Days

Msg. Time   _______ Save Saved Msgs.    _______Days

Total Time   _______

Language    _______ Maximum Rings     _______

AMIS
Highest Outgoing AMIS Option

Not Allowed (if this is Highest Outgoing, user does not have AMIS
Economy Casual
Standard Administered
Priority Reply Max Length   _______
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Message Delivery Schedule

Entry #: Active:
On Time: Off Time:
On Day; Off Day:
Phone #: Callback #:
Max Retries: Busy Delay: No Ans. Delay:

Entry #: Active:
On Time: Off Time:
On Day; Off Day:
Phone #: Callback #:
Max Retries: Busy Delay: No Ans. Delay:

Entry #: Active:
On Time: Off Time:
On Day; Off Day:
Phone #: Callback #:
Max Retries: Busy Delay: No Ans. Delay:

Entry #: Active:
On Time: Off Time:
On Day; Off Day:
Phone #: Callback #:
Max Retries: Busy Delay: No Ans. Delay:

Entry #: Active:
On Time: Off Time:
On Day; Off Day:
Phone #: Callback #:
Max Retries: Busy Delay: No Ans. Delay:

Entry #: Active:
On Time: Off Time:
On Day; Off Day:
Phone #: Callback #:
Max Retries: Busy Delay: No Ans. Delay:

Entry #: Active:
On Time: Off Time:
On Day; Off Day:
Phone #: Callback #:
Max Retries: Busy Delay: No Ans. Delay:

Entry #: Active:
On Time: Off Time:
On Day; Off Day:
Phone #: Callback #:
Max Retries: Busy Delay: No Ans. Delay:
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Attendant Menu Setup

For information on setting up the Attendant menu, see Chapter 4,
“The Attendant Menu.”

________ ________ ________

________ ________ ________

________ ________ ________
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System Prompt Number Record

Morning       ________ Evening ________

Afternoon     ________ Closed ________

Multilingual Selection   ________

Attendant Menu Message Delivery
Language 1 ________ Language 1 ________

Language 2 ________ Language 2 ________

Language 3 ________ Language 3 ________

Language 4 ________ Language 4 ________

Language 5 ________ Language 5 ________

Call Queuing
Call Transfer Prompt __________

1 _______ 4 _______ 7 _______

2 _______ 5  _______ 8 _______

3 _______ 6  _______ 9 _______

Holidays
Date Prompt Retain Date Prompt Retain

1 ___ ______ [  ] 10 ___ ______ [  ]

2 ___ ______ [  ] 11 ___ ______ [  ]

3 ___ ______ [  ] 12 ___ ______ [  ]

4 ___ ______ [  ] 13 ___ ______ [  ]

5 ___ ______ [  ] 14 ___ ______ [  ]

6 ___ ______ [  ] 15 ___ ______ [  ]

7 ___ ______ [  ] 16 ___ ______ [  ]

8 ___ ______ [  ] 17 ___ ______ [  ]

9 ___ ______ [  ] 18 ___ ______ [  ]



TEMPLATES

Octel 50 Supervisor’s Guide A-7

Greetings by Port Setup

Port Active During Hrs
Mailbox

After Hrs
Mailbox

Monday
Open/Close

Tuesday
Open/Close

Wednesday
Open/Close

Thursday
Open/Close

Friday
Open/Close

Saturday
Open/Close

Sunday
Open/Close

1

2

3

4

5

6

7

8

8

10

11

12

13

14

15

16

17

18

19

10

21

22

23

24

25

26

27

28

29

30

31

32
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System Greetings

Main Greeting
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
__________________________

After-Hours Greeting
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________
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Audiotex (Information Boxes)

MB # _____

Greeting
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________

MB # _____

Greeting
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
____________________________________________________
________________________
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Subscriber Record

Ext. Number First Name Last Name

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________

________ ________________ ________________
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Customer Database Information

Company Name ______________________________________

Address
______________________________________________

_____________________________________________

Contact Name _____________    Phone ________________

Phone System Information:

Manufacturer/Model
____________________________________

Software Version
_______________________________________

Configuration: ________       Trunks _______    Stations ______

Call Handling:

Activate Auto Att: Yes No
Auto Attendant: Answering Position Overflow
Rotary Callers: Default to Operator Disconnect

Total Number of Lines/Trunks to be answered _____________

Line/Trunk Pilot Number   _____________

Auto Attendant/Voice Mail Pilot Number   _____________

Auto Attendant/Voice Mail Station Numbers:

1  ______ 9    ______ 17  ______

2  ______ 10  ______ 18  ______

3  ______ 11  ______ 19  ______

4  ______ 12  ______ 20  ______

5  ______ 13  ______ 21  ______

6  ______ 14  ______ 22  ______

7  ______ 15  ______ 23  ______

8  ______ 16  ______ 24  ______
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Notes:



Octel 50 Supervisor’s Guide G-1

G L O S S A R Y  G

Glossary

This section defines key terms used in this guide.
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Administered AIM

A feature of AIM that allows an individual subscriber to dispatch messages to pre-
defined nodes that have been established by the system supervisor. See also
Node Number.

After Hours Greeting

The message that greets a caller during non-business hours.

AIM

AMIS Interface Module. An optional module that allows users to send and receive
messages to and from subscribers on remote voice mail systems that support the
AMIS-analog protocol. The AMIS feature is not available in certain Octel 50
systems.

AMIS

Audio Messaging Interchange Specification. Defines a protocol whereby two
voice mail systems may communicate with each other.

Audiotex

A communications product that enables users to send or receive information via a
telephone connection by using audio input (either voice or DTMF) with a voice
processing system.

Auto Forwarding

A system feature that automatically forwards messages that have not been
listened to from one mailbox to another specified mailbox.

AUTOEXEC.BAT

The batch file that automatically executes when a PC is turned on.

Automated Attendant

A system feature that handles phone calls in a manner similar to a receptionist.

Automatic Station Login

A system feature that allows subscribers immediate access into their mailboxes
when dialing into the system from their own extensions. A password may or may
not be required. This feature is switch-dependent and may or may not be
available on all systems.
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Beeper Notification (See also Message Delivery)

A system feature that instructs the system to dial a subscriber’s beeper when a
message is received in the mailbox.

Beeper Wait

The length of time, in seconds, the system will wait after a connection before
sending the beeper display number to a digital beeper.

Business Hours

The hours that a company is open for business. These hours are used by the
system to determine when to voice the appropriate during and after-hours
greetings.

Call Handling

A system feature that allows a subscriber to use optional prompts, a V-Tree, or
call forwarding to intercept calls to a mailbox either  immediately, if the extension
is busy, if there is no answer at the extension, or if the extension is busy or not
answered.

Call Paging (Intercom Paging)

See Intercom Paging.

Call Queuing

A system feature that gives a caller the option to hold for a specific extension
when that extension is busy. While on hold, callers are informed of their status in
the holding queue, including the number of calls ahead of them. The call queuing
feature can also be set up to provide callers on hold with prerecorded music or
messages.

Call Screening

A system feature that allows subscribers to choose whether or not they want to
take calls.

Casual AIM

A feature of AIM that allows subscribers to dispatch messages to AMIS-analog
compatible remote voice mail systems for which they manually enter the remote
access telephone number and mailbox number.

Checkpoint File

A file that periodically records critical system data so that Octel 50 can resume
system characteristics after the system is turned off and restarted.
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Class of Service (COS)

A group of system parameters activated for one or a set of mailboxes.

Command Line

The area on Octel 50’s PC user interface where a supervisor can type commands
to manipulate system parameters and performance.

Dial-Out Port

See Outbound Port.

Dial-Up Port

See Inbound Port.

Dial Tone

A constant tone used on telephones as a signal that the equipment is ready to
accept a phone number pulse or DTMF information.

DID

A PBX feature that allows a caller to dial a station within the phone system
without the assistance of an attendant. When used with a voice processing
system, the mechanism intercepts the call before the PBX to capture the DID
extension number digits for mailbox identification.

Directory Prompt

A prompt that callers hear when they request to listen to the system’s subscriber
directory. For example, “For John Smith, please press two, three, four.”

Dispatch

The action of sending a message to a voice mail system that supports the AMIS
protocol. Dispatch options that may be available to subscribers are economy,
standard, and priority.

Distribution Lists

A system feature that allows a subscriber to send the same message to a group
of subscribers in one step.

DTMF

Dual Tone Modulated Frequency. The two distinct frequencies emitted when a
digit on a push-button phone is pressed.
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Economy Dispatch

A network messaging dispatch option that holds messages in an economy queue
defined by the system supervisor. The queue’s dispatch time frame is usually
defined for an off-peak rate period. During that time, all messages queued for
economy dispatch are delivered to the remote network address.

Extended Password Security

A system security feature used with variable length passwords that requires
subscribers to press the <#> key after entering their passwords.

Fax Retrieval

A Octel 50 add-on module that faxes documents stored on the system to callers
who request them through the V-Tree feature.

Flash Hook

Quickly depressing and releasing the buttons in the cradle of a telephone.

Folders

Recorded headings in a mailbox under which subscribers can store messages
(voice or fax) they want to save.

Future Delivery

A system feature that permits a message to be sent at a future time. Subscribers
must have priority dispatch ability if they want to mark an AMIS message for
Future Delivery.

Greeting

An announcement that a caller hears after dialing the company’s phone number
or subscriber’s extension.

Greeting by Port

A system feature that plays specific greetings for incoming calls to certain ports.
This feature enables several businesses in an office complex to share one
system and still have unique office greetings.

Holiday Greeting

A message that greets callers on those dates specified as holidays when the
office is closed.
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Hook Switch

The buttons located in the cradle of a telephone, used to create a flash hook
when quickly pressed and released.

Inbound Port

A port defined in System Setup to accept incoming calls.

Intercom Paging (Call Paging)

A system feature that allows callers dialing an unanswered extension to have the
party they want to speak with paged over the telephone system’s intercom aging
capability.

Integration

The ability to link a voice mail environment to a PBX.

Intercom Redirect

A system feature that allows a paged subscriber to alert the system of an
alternate extension or mailbox number to which the call is to be transferred.

Keyboard Functions

Those system functions controlled through the computer keyboard.

Line Statistics

Data for each line or port.

Line Status

The activity of each line or port; the status displays whether a port is in use or
waiting for a ring.

Listen-Only Message

A message that can only be listened to and possibly reviewed, depending on
system setup.

Mailbox

A system destination from which a subscriber can access many system functions.
Also, a mailbox holds all messages sent to the subscriber. A subscriber’s mailbox
number may or may not be the same as the subscriber’s extension number.
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Mailbox ID

The portion of an address that identifies the sender/recipient of an AMIS
message.

Main Menu

The first set of options that subscribers hear when accessing their mailboxes.

Message

A vocal or fax communication sent to a subscriber’s mailbox by either another
subscriber or an outside caller.

Message Confirmation

A system feature that enables a subscriber to determine if another subscriber has
received a certain message. A message is considered “confirmed” when the
intended recipient has listened to or skipped it.

Message Delivery (See also Beeper Notification)

A system feature that instructs the system to call subscribers at a specified
number when messages are received in their mailbox.

Message Scanning

A system feature that allows a mailbox owner to scan messages in the new
message queue for entries from a particular local subscriber.

Message Waiting Lights (MWLs)

The lights or display on a telephone that notify a user of a message.

Name Prompt

A prompt, containing only a subscriber’s name, which the system inserts into
many of its voice phrases. For example, “John Smith.”

Networking Address

The telephone number and Mailbox ID of a remote destination.

Node Number

A unique number assigned by the system supervisor that subscribers use when
dispatching messages to a remote voice mail system that supports the AMIS-
analog protocol.
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Non-Delivery Notification

A status message returned to the sender of an AMIS or fax message that could
not be delivered to its recipient.

Non-Subscriber

A person who calls into the system and does not have an assigned mailbox.

Operator

The person, usually the receptionist, to whom the system defaults. Callers can
dial this extension or be automatically transferred to it.

Operator Commands

Those commands entered at the Octel 50 opening screen to manipulate the
system.

Optional Prompts

A prompt a subscriber can record to answer the subscriber’s extension and
forward callers directly to the mailbox. For example, “Hi. You have reached John
Smith. I’m in a meeting right now, so please press two to leave a message or
press zero to speak to the operator.”

Options Menu

Option <9> from the Subscriber’s Main menu. The Option menu allows
subscribers to configure their mailboxes.

Outbound Port

A port defined in System Setup to be used for outcalling.

Outcall/Outdial

A term used when the system places a call. A system outcalls to deliver AMIS
messages, for message delivery, or for wake-up call notification.

Password

A group of characters that uniquely identifies a user who wants to gain access to
certain applications. The supervisor can define a minimum length of digits for a
user password in System Setup.

Personal Distribution Lists

Ten distribution lists a subscriber can define and use to facilitate message
delivery to multiple destinations.
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Personal Greeting Prompt

A prompt that can be recorded by a subscriber when callers request to be
transferred to a subscriber’s mailbox. For example, “Hi. This is John. I’m sorry I
cannot take your call right now. Please leave a message, and I’ll return your call
as soon as possible.”

Personal Network Address (PNA)

A system feature that allows a subscriber to program up to 20 (*20-*39)
addresses for subscribers of a remote voice mail system that supports the AMIS-
analog protocol. Each PNA consists of 1 remote phone number and mailbox
number.

Personal Operator

The extension to which a call defaults when the caller requests a mailbox and is
later transferred to an operator.

Personalized Prompts

Six mailbox prompts that can be recorded by a subscriber.

Please Hold Prompt

The prompt that a caller hears as he is being transferred to the requested
extension. For example, “Please hold for John Smith.”

Port

A telephone voice circuit connection on a voice processing system.

Priority Dispatch

A network messaging dispatch option that delivers the message to the remote
networking address at the earliest opportunity.

Private Message

A message intended for one subscriber that cannot be forwarded.

Prompts

Audio information from a voice system that guides the user’s interaction with the
system.

Queued Dispatch

See Standard Dispatch.
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Recipient

The user who receives a message.

Regular Message

A message sent without any special delivery functions.

Security Access Levels

Three levels that use passwords to control a supervisor’s access to different
System Setup and configuration parameters.

SO3-ALL.VAP or SO3-ALL.VOX

Files containing the standard and application voice phrases.

SO3-D1.VAP or SO3-D1.VOX

Files containing the disk application phrases.

SO3-D2.VAP or SO3-D2.VOX

Files containing the custom phrases, such as call queuing and V-Tree phrases.

SOLVE

Supervisor On-Line Voice Editor. Allows the supervisor to record prompts while
working from the Octel 50 screens.

Standard Dispatch

A network messaging dispatch option that places the message in a queue for a
period of time established by the system supervisor.

Subscriber

A person to whom a mailbox has been assigned.

Subscriber Password

The password used by a subscriber to access the subscriber’s mailbox.

Supervised Call

A call monitored by the system to determine if the requested line returns a busy
or ring-no-answer condition. If so, the call is not transferred to the line, and the
caller is given other options.
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Supervisor

The person responsible for the maintenance of the system. The supervisor also
authorizes the use of special system features.

Supervisor Password

The password used by the supervisor to access supervisor functions.

System Distribution Lists

Ten distribution lists a supervisor can define and make available to subscribers
for their use. System distribution lists cannot be modified by subscribers.

System ID

See Node Number.

System Setup

The portion of Octel 50 software responsible for customizing the application to
meet individual needs.

Talkoff

A condition that occurs when a voice processing system mistakenly interprets a
voice as a DTMF.

Touch-Tone

The AT&T registered trademark for DTMF tones.

Transmission Failure

A term used when an AMIS message cannot be delivered to its intended
recipient. See also Non-Delivery Notification.

Urgent Message

A message sending option that places the message at the top of a subscriber’s
new message queue.

Visual V-Trees

A system feature that allows a V-Tree to be created onscreen.

Voice Mail

The process of recording, storing, and retrieving messages using a telephone
system and a PC.
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V-Tree

A built-in, Touch-Tone-programmable audiotex/call routing application generator
for individual mailboxes. V-Trees allow subscribers to create multilevel voice
menus within the system. See also Visual V-Trees.

Wake-Up Call

A system feature that allows a subscriber to enter a date and time that the system
is to place a call to a specified phone number.
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Index

A

Activate fields, 3-2

Administered AMIS, definition, 7-18

Advance to next level (V-Tree action
code), 11-3

After hours mailbox, 7-3

Afternoon prompt, 4-6

AIM options
administered, 7-18
casual, 7-18
economy, 7-17
not allowed, 7-17
priority, 7-17
reply, 7-18
standard, 7-17

AMIS Statistics report, 5-10

AMIS, 7-17
maintenance, 7-18
Personal Network Address (PNA), 7-9

Application Statistics report, 5-16

Attendant menu options
mailbox number, 4-2
message, 4-3

Attendant Menu prompt, 4-7

Attendant menu, 4-2, 4-7
business hours, 4-9
holidays, 4-3

Auto forward messages, 3-7

Automated Attendant
definition of, 4-1

B

Batch Mode delivery option, 7-13

Batch mode, 3-8

Blocking calls to a mailbox, 3-15

Business hours, 4-9
after hours mailbox, 7-3
closed all day, 4-9
closed during selected hours, 4-10
open all day, 4-9
setting up, 4-9

Buttons, 1-2

C

Call blocking, 3-15

Call forwarding, 3-15

Call handling, 3-14, 7-10
busy options, 3-15
call blocking, 3-15
call forwarding, 3-15
no answer options, 3-15

Call queuing, 3-16

Call queuing, 7-7
prompt, 4-8

Call screening, 3-16, 7-6

Call transfer codes, 3-14

Call Transfer prompt, 4-8

Callback number for message delivery,
3-11

Calls Per Hour display, 6-5

Casual AMIS, definition, 7-18

Change
distribution lists, 10-8
password, 2-4
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screen colors, 7-26
system prompts, 10-8

Channel Status
display, 6-3
Next Channel, 6-5

Class of service, 7-5
AMIS, 7-17
call handling, 7-10
call queuing, 7-7
call screening, 7-6
change, 10-6
Class of Service report, 5-8
confirmation, 7-6
days to save new messages, 7-15
days to save saved messages, 7-16
directory access, 7-9
distribution list, 7-8
fax, 7-10
fax options, 7-14
global distribution list, 7-9
highest outgoing dispatch, 7-17
intercom paging, 7-8
language, 7-15
maximum message length, 7-18
maximum messages, 7-14
maximum rings, 7-16
message delivery, 7-12
message length, 7-15
message light, 7-8
message scan, 7-11
operator access, 7-12
Personal Network Address (PNA), 7-9
receive faxes, 7-14
receive messages, 7-11
record prompts, 7-12
save messages, 7-11
send faxes, 7-14
send messages, 7-11
sent message editing, 7-12
supervisor, 7-12
total time, 7-15
undelete messages, 7-11
voice folders, 7-7
V-Tree, 7-10

Clear mailbox, 3-21

Closed prompt, 4-6

Code for custom call transfer, 3-14

Colors, change, 7-26

Command Line Interface display, 6-4

Commands. See Operator commands

Confirmation of messages, 7-6

Copy mailbox, 3-18

Create
distribution list, 10-8
guest mailbox, 3-16
mailboxes, 3-2
node, 7-19
V-Trees, 11-6, 11-8

Custom call transfer codes, 3-14

Custom class of service options, 7-5

D

Daily business hours
closed all day, 4-9
open all day, 4-9
selected hours, 4-10
setting up, 4-9

Date/time, 1-3

Default passwords, 2-2

Delete
distribution list, 10-9
guest mailbox, 3-17
mailbox, 3-20
nodes, 7-23
V-Trees, 11-11

Delivery options
batch mode, 7-13
local only, 7-13
long distance, 7-13
not allowed, 7-13
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Directory prompt, 10-4

Directory access, 7-9

Disconnect  (V-Tree action code), 11-4

Dispatch, highest outgoing for AMIS,
7-17

Display menu, 6-1
100% Contention, 6-8
50% Contention, 6-7
Calls Per Hour, 6-5
Channel Status, 1-3, 6-3
Command Line Interface, 6-4
Mailbox Status, 1-3, 6-2
Next Channel Status, 6-5
System Usage, 6-6

Distribution List, 7-8
change, 10-8
create, 10-8
delete, 10-9
global, 7-9
review/update, 10-9

Duplicate mailboxes, 3-18

E

Economy
AIM messaging, 7-17
highest outgoing dispatch, 7-17

Edit
distribution lists, 10-8
mailbox, 3-19
nodes, 7-22
sent message, 7-12
system prompts, 10-8
V-Trees, 11-6, 11-8

Evening prompt, 4-6

Exit system, 2-5

F

Fax, 7-10
mailbox options, 7-14
receive faxes in mailbox, 7-14

Send a requested fax and advance (V-
Tree action code), 11-5

send faxes from mailbox, 7-14
Send predefined fax and advance (V-

Tree action code), 11-5

Fields, 1-2

Fifty % Contention display, 6-7

File menu, 2-1
change password, 2-4
exit, 2-5
logoff, 2-5
password, 2-2

Find mailbox, 3-23

Folders, 7-7

Force shutdown, 2-6

Forward messages, auto, 3-7

G

Generating reports, 5-2

Global distribution list, 7-9

Go to directory services (V-Tree action
code), 11-4

Go to mailbox entry (V-Tree action
code), 11-4

Greetings by Port, 7-2
after hours mailbox, 7-3
Port Assignments report, 5-6

Guest mailbox, create, 3-16

H

Help menu, 8-1

Highest outgoing dispatch, 7-17
economy, 7-17
not allowed, 7-17
priority, 7-17
standard, 7-17

Holidays, 4-3
greetings, 4-8
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Hourly Statistics report, 5-16

I

Incoming calls display, 6-5

Intercom paging, 3-13, 7-8

L

Language Select prompt, 4-7

Languages, select for mailbox, 7-15

Level 1, 2, & 3 supervisor access, 2-2

Line Statistics report, 5-15

Local Only delivery option, 7-13

Logging into the system, 2-3

Logging off the system, 2-5

Long Distance delivery option, 7-13

M

Mailbox
Mailbox Status display, 1-3
status, 1-3

Mailboxes
auto forward messages, 3-7
call blocking options, 3-15
call forwarding, 3-15
call handling, 3-14
call queuing, 3-16
call screening, 3-16
clear information, 3-21
copy, 3-18
create, 3-2
create duplicate mailboxes, 3-18
days to save messages, 7-15
delete, 3-20
distribution list, 10-8
edit, 3-19
fax options, 7-14
guest mailbox, 3-16
language, 7-15
Mailbox Entry dialog box, 3-2

Mailbox Information reports, 5-4
Mailbox menu, 3-1
Mailbox Status display, 6-2
Mailbox Usage report, 5-3
maximum message length, 7-15
maximum message length (AMIS),

7-18
maximum number of messages

allowed, 7-14
maximum number of rings before no

answer, 7-16
Quick List report, 5-3
search for, 3-23
subscriber settings, 3-12
total message time, 7-15
troubleshooting, 12-12
update, 3-19
Visual V-Trees, 3-17

Main menu, 1-3
fields, 1-3
options, 1-3

Maximum
message length, 7-15
number of messages, 7-14
number of rings before no answer,

7-16

Menus
Attendant, 4-2, 4-7
Display, 6-1
Help, 8-1
Reports, 5-1
selecting, 1-3
Supervisor, 10-2

Message Delivery
prompt, 4-7

Message
auto forward, 3-7
batch mode for message delivery, 3-8
days to save messages, 7-15
days to save new messages, 7-15
days to save saved messages, 7-16
edit sent, 7-12
highest outgoing dispatch, 7-17
length of AMIS message, 7-18
length of message, 7-15
maximum message length, 7-15
maximum number of messages, 7-14
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message delivery, 3-8, 7-12
message delivery callback number,

3-11
message onfirmation, 7-6
message waiting light, 7-8
receive messages, 7-11
record prompts, 7-12
save messages, 7-11
scan messages, 7-11
send messages, 7-11
sent message editing, 7-12
total message time, 7-15
troubleshooting, 12-19
undelete, 7-11

Morning prompt, 4-6

N

Name prompt, 10-4

Node Information report, 5-13

Node, 7-18
creating, 7-19
deleting, 7-23
editing, 7-22
searching for, 7-24

Not Allowed
AIM messaging, 7-17
delivery option, 7-13
highest outgoing dispatch, 7-17

O

Octel 50 Main menu, 1-3

One Hundred % Contention display, 6-8

Operator commands, 9-1
Closed, 9-2
CLRPRT, 9-2
CLS, 9-2
Copy, 9-3
Date, 9-3
DEBUG, 9-3
DIGRAB (Digit Grabber), 9-4
DIS (Disable Port), 9-4
Drop, 9-4

ENA, 9-5
Force, 9-5
Line Interface, 9-2
MEMSTAT, 9-5
Open, 9-6
Repeat (=), 9-8
Restart, 9-6
Shutdown, 9-6
Status, 9-7
STRESET, 9-7
SYSLOOK, 9-7
Time, 9-8
Version, 9-8

Operator
access, 7-12
change default, 10-6

Options menu, 7-1
AMIS maintenance, 7-18
class of service, 7-5
Greetings By Port, 7-2
screen configuration, 7-26

Options on the Main menu, 1-3

P

Password, 2-2
change, 2-4, 10-6
default, 2-2
length, 2-4
supervisor level 1, 2, & 3, 2-2

Personal Greeting prompt, 10-4
change, 10-6

Personal Network Address (PNA), 7-9

Phrases
SO3-D2.VAP, 5-9
SO3-D2.VOX, 5-9

Please Hold prompt, 10-4

Ports
Port Assignments report, 5-6
view status, 6-3

Priority
AIM messaging, 7-17
highest outgoing dispatch, 7-17



INDEX

Octel 50 Supervisor’s Guide I-6

Prompts, 4-5
Afternoon, 4-6
Attendant Menu, 4-7
Call Queuing, 4-8
Call Transfer, 4-8
change, 10-6, 10-8
Closed, 4-6
customizing, 4-5
Directory, 10-4
Evening, 4-6
Holiday Greetings, 4-3, 4-8
Language Select, 4-7
Message Delivery, 4-7
Morning, 4-6
Name, 10-4
Personal Greetings, 10-4
Please Hold, 10-4
Prompt Assignments report, 5-9
prompt numbers, 4-5
record, 7-12, 10-8
System Greeting, 4-6

Propeller, 1-2

R

Receive faxes in mailbox, 7-14

Record to mailbox and advance (V-Tree
action code), 11-4

Record to mailbox and return (V-Tree
action code), 11-3

Record
prompts, 10-4, 10-10

Reports menu, 5-1
generate reports, 5-2

Reports
AMIS Statistics, 5-10
Application Statistics, 5-16
Class of Service, 5-8
company field, 5-2
division field, 5-2
Hourly Statistics, 5-16
Line Statistics report, 5-15
Mailbox Information, 5-4
Mailbox Quick List, 5-3
Mailbox Usage, 5-3

Node Information, 5-13
Port Assignments report, 5-6
print, 5-2
Prompt Assignments, 5-9
save, 5-2

Reset mailbox statistics, 3-21

Restart the system, 1-4

Return to previous V-Tree level (V-Tree
action code), 11-4

Review/edit message (V-Tree action
code), 11-5

RUNSMO3, 1-4

S

Save
messages, 7-11
saved messages, 7-16
screen layout, 7-28

Screen configuration, 7-26
change colors, 7-26
save screen layout, 7-28
set to defaults, 7-28

Screens
Mailbox Status display, 6-2
Main menu, 1-3
system, 1-2

Search
for a mailbox, 3-23
for a node, 7-24

Security, 2-2

Select
button, 1-2
Language prompt, 4-7
menu, 1-3

Send predefined fax and
advance(V-Tree action code), 11-5

Send faxes from mailbox, 7-14

Setting up
call blocking, 3-15
call handling, 3-14
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call screening, 3-16
daily business hours, 4-9
intercom paging, 3-13
nodes, 7-19

Settings for subscriber, 3-12

Shutting down the system, 2-6

Shutting down SOLVE, 10-11

SO3.VOX, 5-9

SO3-D2.VAP, 5-9

SOLVE
recording prompts, 10-11
shutting down, 10-11
starting, 10-10
using, 10-10

Standard
AIM messaging, 7-17
highest outgoing dispatch, 7-17

Starting SOLVE, 10-10

Status
Channel Status, 1-3, 6-3
Mailbox Status, 1-3, 6-2
Next Channel, 6-5

Subscriber
settings, 3-12
troubleshooting, 12-10

Supervisor Keypad Functions, 10-1

Supervisor menu, accessing, 10-2

Supervisor menu
add a mailbox, 10-3
delete a mailbox, 10-6
mailbox functions, 10-3
reset a mailbox, 10-7
update a mailbox, 10-5

Supervisor, 7-12
default passwords, 2-2
troubleshooting, 12-9

System
distribution lists, 10-8
DOS interface, 6-4
exit, 2-5
log into, 2-3

restart, 1-4
screens, 1-2
shutdown, 2-5
system setup, 7-25
System Usage display, 6-6
time available, 6-6

T

Templates for configuration, 1-4

Time available on system, 6-6

Time/date, 1-3

Transfer to a mailbox (V-Tree action
code), 11-3

Transfer to mailbox login (V-Tree action
code), 11-6

Transfer to voice mail (V-Tree action
code), 11-4

Transfer
Call Transfer prompt, 4-8
custom codes, 3-14

Troubleshooting, 12-1
mailbox feature issues, 12-13
mailbox issues, 12-12
message issues, 12-19
selecting item issues, 12-8
subscriber action issues, 12-10
supervisor action issues, 12-9
system feature issues, 12-6
system issues, 12-2

V

View
Channel Status display, 6-3
Mailbox Status display, 6-2

Visual V-Tree, 11-6

Visual V-Trees, 3-17

Voice Editor
Supervisor’s On-Line, 10-10
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Voice folders, 7-7

Voice mail attendant setup, 7-25

V-Tree action codes, 11-3
about V-Trees, 11-2
activating for a mailbox, 11-12
Advance to the Next Level, 11-3
create using phone interface, 11-8
create using Visual V-Tree, 11-6
definition of, 11-1
delete using phone interface, 11-11
Disconnect caller, 11-4
edit, 11-6, 11-8
fax retrieval, 11-5
fax V-Tree, 7-10
Go to mailbox entry, 11-4
Record and proceed to next menu,

11-4
Record to a mailbox and return, 11-3
Return to previous level, 11-4
Review/edit message, 11-5
Send predefined fax and advance,

11-5
Send requested fax and advance,

11-5
Transfer to a Mailbox, 11-3
Transfer to directory services, 11-4
Transfer to mailbox login, 11-6
Transfer to voice mail, 11-4
Visual V-Tree, 11-6


